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Turn project into package,  
Enable roxygen documentation with 
 Tools > Project Options > Build Tools

Roxygen guide at  
Help > Roxygen Quick Reference

File > New Project >  
New Directory > R Package

Share Project 
with Collaborators

Active shared 
collaborators

Select  
R Version

Start new R Session 
in current  project 

Close R 
Session in 
project 

JHT

RStudio saves the call history, 
workspace, and working 
directory associated with a 
project. It reloads each when 
you re-open a project. 

Name of 
current project

View(<data>) opens spreadsheet like view of data set

Sort by 
values

Filter rows by value 
or value range

Search 
for value

Viewer Pane displays HTML content, such as Shiny apps, 
RMarkdown reports, and interactive visualizations

Stop Shiny 
app

Publish to shinyapps.io, 
rpubs, RSConnect, …

Refresh 

RStudio opens documentation in a dedicated Help pane

Home page of 
helpful links 

Search within 
help file

Search for 
help file

GUI Package manager lists every installed package

Click to load package with 
library(). Unclick to detach 
package with detach()

Delete 
from 
library

Install 
Packages

Update 
Packages

Create reproducible package 
library for your project

RStudio opens plots in a dedicated Plots pane

Navigate 
recent plots

Open in 
window

Export 
plot

Delete 
plot

Delete 
all plots

Package 
version 
installed

Examine variables 
in executing 
environment

Open with debug(), browser(), or a breakpoint. RStudio will open the 
debugger mode when it encounters a breakpoint while executing code.

Open traceback to examine 
the functions that R called 
before the error occurred

Launch debugger 
mode from origin 
of error

Click next to 
line number to 
add/remove a 
breakpoint.

Select function 
in traceback to 
debug

Highlighted 
line shows 
where 
execution has 
paused

Run commands in 
environment where 
execution has paused

Step through 
code one line 
at a time

Step into and 
out of functions 
to run

Resume 
execution

Quit debug 
mode

Open Shiny, R Markdown, 
knitr, Sweave, LaTeX, .Rd files 
and more in Source Pane

Check 
spelling

Render 
output

Choose 
output 
format

Choose 
output 
location

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
selected 
lines

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunk

Jump to 
chunk

RStudio recognizes that files named app.R, 
server.R, ui.R, and global.R belong to a shiny app

Run 
app

Choose 
location to 
view app

Publish to 
shinyapps.io 
or server

Manage 
publish 
accounts

Access markdown guide at  
Help > Markdown Quick Reference

Stage 
files:

Show file 
diff

Commit 
staged files

Push/Pull  
to remote

View 
History

current 
branch

• Added 
• Deleted 
• Modified 
• Renamed 
• Untracked

Turn on at Tools > Project Options > Git/SVN

Open shell to 
type commands

A

D

M

R

?

Search inside 
environment

Syntax highlighting based 
on your file's extension

Code diagnostics that appear in the margin. 
Hover over diagnostic symbols for details.

Tab completion to finish 
function names, file paths, 
arguments, and more.

Multi-language code 
snippets to quickly use 
common blocks of code.

Open in new 
window

Save Find and 
replace

Compile as 
notebook

Run 
selected 
code

Re-run 
previous code

Source with or 
without Echo

Show file 
outline

Jump to function in file Change file type

Navigate 
tabs

A File browser keyed to your working directory. 
Click on file or directory name to open.

Path to displayed directory

Upload 
file 

Create 
folder

Delete 
file 

Rename 
file 

Change  
directory

Displays saved objects by 
type with short description

View function 
source code

View in data 
viewer

Load 
workspace

Save 
workspace

Import data 
with wizard

Delete all 
saved objects

Display objects 
as list or grid

Choose environment to display from 
list of parent environments

History of past 
commands to 
run/copy

Display .RPres slideshows 
File > New  File >  
R Presentation

Working 
Directory

Maximize, 
minimize panes
Drag pane 
boundaries

JHT

Cursors of 
shared users

File > New Project

Press � to see 
command history

Multiple cursors/column selection 
with Alt + mouse drag.
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Turn project into package,  
Enable roxygen documentation with 
 Tools > Project Options > Build Tools

Roxygen guide at  
Help > Roxygen Quick Reference

File > New Project >  
New Directory > R Package

Share Project 
with Collaborators

Active shared 
collaborators

Select  
R Version

Start new R Session 
in current  project 

Close R 
Session in 
project 

JHT

RStudio saves the call history, 
workspace, and working 
directory associated with a 
project. It reloads each when 
you re-open a project. 

Name of 
current project

View(<data>) opens spreadsheet like view of data set

Sort by 
values

Filter rows by value 
or value range

Search 
for value

Viewer Pane displays HTML content, such as Shiny apps, 
RMarkdown reports, and interactive visualizations

Stop Shiny 
app

Publish to shinyapps.io, 
rpubs, RSConnect, …

Refresh 

RStudio opens documentation in a dedicated Help pane

Home page of 
helpful links 

Search within 
help file

Search for 
help file

GUI Package manager lists every installed package

Click to load package with 
library(). Unclick to detach 
package with detach()

Delete 
from 
library

Install 
Packages

Update 
Packages

Create reproducible package 
library for your project

RStudio opens plots in a dedicated Plots pane

Navigate 
recent plots

Open in 
window

Export 
plot

Delete 
plot

Delete 
all plots

Package 
version 
installed

Examine variables 
in executing 
environment

Open with debug(), browser(), or a breakpoint. RStudio will open the 
debugger mode when it encounters a breakpoint while executing code.

Open traceback to examine 
the functions that R called 
before the error occurred

Launch debugger 
mode from origin 
of error

Click next to 
line number to 
add/remove a 
breakpoint.

Select function 
in traceback to 
debug

Highlighted 
line shows 
where 
execution has 
paused

Run commands in 
environment where 
execution has paused

Step through 
code one line 
at a time

Step into and 
out of functions 
to run

Resume 
execution

Quit debug 
mode

Open Shiny, R Markdown, 
knitr, Sweave, LaTeX, .Rd files 
and more in Source Pane

Check 
spelling

Render 
output

Choose 
output 
format

Choose 
output 
location

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
selected 
lines

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunk

Jump to 
chunk

RStudio recognizes that files named app.R, 
server.R, ui.R, and global.R belong to a shiny app

Run 
app

Choose 
location to 
view app

Publish to 
shinyapps.io 
or server

Manage 
publish 
accounts

Access markdown guide at  
Help > Markdown Quick Reference

Stage 
files:

Show file 
diff

Commit 
staged files

Push/Pull  
to remote

View 
History

current 
branch

• Added 
• Deleted 
• Modified 
• Renamed 
• Untracked

Turn on at Tools > Project Options > Git/SVN

Open shell to 
type commands

A

D

M

R

?

Search inside 
environment

Syntax highlighting based 
on your file's extension

Code diagnostics that appear in the margin. 
Hover over diagnostic symbols for details.

Tab completion to finish 
function names, file paths, 
arguments, and more.

Multi-language code 
snippets to quickly use 
common blocks of code.

Open in new 
window

Save Find and 
replace

Compile as 
notebook

Run 
selected 
code

Re-run 
previous code

Source with or 
without Echo

Show file 
outline

Jump to function in file Change file type

Navigate 
tabs

A File browser keyed to your working directory. 
Click on file or directory name to open.

Path to displayed directory

Upload 
file 

Create 
folder

Delete 
file 

Rename 
file 

Change  
directory

Displays saved objects by 
type with short description

View function 
source code

View in data 
viewer

Load 
workspace

Save 
workspace

Import data 
with wizard

Delete all 
saved objects

Display objects 
as list or grid

Choose environment to display from 
list of parent environments

History of past 
commands to 
run/copy

Display .RPres slideshows 
File > New  File >  
R Presentation

Working 
Directory

Maximize, 
minimize panes
Drag pane 
boundaries

JHT

Cursors of 
shared users

File > New Project

Press � to see 
command history

Multiple cursors/column selection 
with Alt + mouse drag.
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Turn project into package,  
Enable roxygen documentation with 
 Tools > Project Options > Build Tools

Roxygen guide at  
Help > Roxygen Quick Reference

File > New Project >  
New Directory > R Package

Share Project 
with Collaborators

Active shared 
collaborators

Select  
R Version

Start new R Session 
in current  project 

Close R 
Session in 
project 

JHT

RStudio saves the call history, 
workspace, and working 
directory associated with a 
project. It reloads each when 
you re-open a project. 

Name of 
current project

View(<data>) opens spreadsheet like view of data set

Sort by 
values

Filter rows by value 
or value range

Search 
for value

Viewer Pane displays HTML content, such as Shiny apps, 
RMarkdown reports, and interactive visualizations

Stop Shiny 
app

Publish to shinyapps.io, 
rpubs, RSConnect, …

Refresh 

RStudio opens documentation in a dedicated Help pane

Home page of 
helpful links 

Search within 
help file

Search for 
help file

GUI Package manager lists every installed package

Click to load package with 
library(). Unclick to detach 
package with detach()

Delete 
from 
library

Install 
Packages

Update 
Packages

Create reproducible package 
library for your project

RStudio opens plots in a dedicated Plots pane

Navigate 
recent plots

Open in 
window

Export 
plot

Delete 
plot

Delete 
all plots

Package 
version 
installed

Examine variables 
in executing 
environment

Open with debug(), browser(), or a breakpoint. RStudio will open the 
debugger mode when it encounters a breakpoint while executing code.

Open traceback to examine 
the functions that R called 
before the error occurred

Launch debugger 
mode from origin 
of error

Click next to 
line number to 
add/remove a 
breakpoint.

Select function 
in traceback to 
debug

Highlighted 
line shows 
where 
execution has 
paused

Run commands in 
environment where 
execution has paused

Step through 
code one line 
at a time

Step into and 
out of functions 
to run

Resume 
execution

Quit debug 
mode

Open Shiny, R Markdown, 
knitr, Sweave, LaTeX, .Rd files 
and more in Source Pane

Check 
spelling

Render 
output

Choose 
output 
format

Choose 
output 
location

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
selected 
lines

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunk

Jump to 
chunk

RStudio recognizes that files named app.R, 
server.R, ui.R, and global.R belong to a shiny app

Run 
app

Choose 
location to 
view app

Publish to 
shinyapps.io 
or server

Manage 
publish 
accounts

Access markdown guide at  
Help > Markdown Quick Reference

Stage 
files:

Show file 
diff

Commit 
staged files

Push/Pull  
to remote

View 
History

current 
branch

• Added 
• Deleted 
• Modified 
• Renamed 
• Untracked

Turn on at Tools > Project Options > Git/SVN

Open shell to 
type commands

A

D

M

R

?

Search inside 
environment

Syntax highlighting based 
on your file's extension

Code diagnostics that appear in the margin. 
Hover over diagnostic symbols for details.

Tab completion to finish 
function names, file paths, 
arguments, and more.

Multi-language code 
snippets to quickly use 
common blocks of code.

Open in new 
window

Save Find and 
replace

Compile as 
notebook

Run 
selected 
code

Re-run 
previous code

Source with or 
without Echo

Show file 
outline

Jump to function in file Change file type

Navigate 
tabs

A File browser keyed to your working directory. 
Click on file or directory name to open.

Path to displayed directory

Upload 
file 

Create 
folder

Delete 
file 

Rename 
file 

Change  
directory

Displays saved objects by 
type with short description

View function 
source code

View in data 
viewer

Load 
workspace

Save 
workspace

Import data 
with wizard

Delete all 
saved objects

Display objects 
as list or grid

Choose environment to display from 
list of parent environments

History of past 
commands to 
run/copy

Display .RPres slideshows 
File > New  File >  
R Presentation

Working 
Directory

Maximize, 
minimize panes
Drag pane 
boundaries

JHT

Cursors of 
shared users

File > New Project

Press � to see 
command history

Multiple cursors/column selection 
with Alt + mouse drag.
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Turn project into package,  
Enable roxygen documentation with 
 Tools > Project Options > Build Tools

Roxygen guide at  
Help > Roxygen Quick Reference

File > New Project >  
New Directory > R Package

Share Project 
with Collaborators

Active shared 
collaborators

Select  
R Version

Start new R Session 
in current  project 

Close R 
Session in 
project 

JHT

RStudio saves the call history, 
workspace, and working 
directory associated with a 
project. It reloads each when 
you re-open a project. 

Name of 
current project

View(<data>) opens spreadsheet like view of data set

Sort by 
values

Filter rows by value 
or value range

Search 
for value

Viewer Pane displays HTML content, such as Shiny apps, 
RMarkdown reports, and interactive visualizations

Stop Shiny 
app

Publish to shinyapps.io, 
rpubs, RSConnect, …

Refresh 

RStudio opens documentation in a dedicated Help pane

Home page of 
helpful links 

Search within 
help file

Search for 
help file

GUI Package manager lists every installed package

Click to load package with 
library(). Unclick to detach 
package with detach()

Delete 
from 
library

Install 
Packages

Update 
Packages

Create reproducible package 
library for your project

RStudio opens plots in a dedicated Plots pane

Navigate 
recent plots

Open in 
window

Export 
plot

Delete 
plot

Delete 
all plots

Package 
version 
installed

Examine variables 
in executing 
environment

Open with debug(), browser(), or a breakpoint. RStudio will open the 
debugger mode when it encounters a breakpoint while executing code.

Open traceback to examine 
the functions that R called 
before the error occurred

Launch debugger 
mode from origin 
of error

Click next to 
line number to 
add/remove a 
breakpoint.

Select function 
in traceback to 
debug

Highlighted 
line shows 
where 
execution has 
paused

Run commands in 
environment where 
execution has paused

Step through 
code one line 
at a time

Step into and 
out of functions 
to run

Resume 
execution

Quit debug 
mode

Open Shiny, R Markdown, 
knitr, Sweave, LaTeX, .Rd files 
and more in Source Pane

Check 
spelling

Render 
output

Choose 
output 
format

Choose 
output 
location

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
selected 
lines

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunk

Jump to 
chunk

RStudio recognizes that files named app.R, 
server.R, ui.R, and global.R belong to a shiny app

Run 
app

Choose 
location to 
view app

Publish to 
shinyapps.io 
or server

Manage 
publish 
accounts

Access markdown guide at  
Help > Markdown Quick Reference

Stage 
files:

Show file 
diff

Commit 
staged files

Push/Pull  
to remote

View 
History

current 
branch

• Added 
• Deleted 
• Modified 
• Renamed 
• Untracked

Turn on at Tools > Project Options > Git/SVN

Open shell to 
type commands

A

D

M

R

?

Search inside 
environment

Syntax highlighting based 
on your file's extension

Code diagnostics that appear in the margin. 
Hover over diagnostic symbols for details.

Tab completion to finish 
function names, file paths, 
arguments, and more.

Multi-language code 
snippets to quickly use 
common blocks of code.

Open in new 
window

Save Find and 
replace

Compile as 
notebook

Run 
selected 
code

Re-run 
previous code

Source with or 
without Echo

Show file 
outline

Jump to function in file Change file type

Navigate 
tabs

A File browser keyed to your working directory. 
Click on file or directory name to open.

Path to displayed directory

Upload 
file 

Create 
folder

Delete 
file 

Rename 
file 

Change  
directory

Displays saved objects by 
type with short description

View function 
source code

View in data 
viewer

Load 
workspace

Save 
workspace

Import data 
with wizard

Delete all 
saved objects

Display objects 
as list or grid

Choose environment to display from 
list of parent environments

History of past 
commands to 
run/copy

Display .RPres slideshows 
File > New  File >  
R Presentation

Working 
Directory

Maximize, 
minimize panes
Drag pane 
boundaries

JHT

Cursors of 
shared users

File > New Project

Press � to see 
command history

Multiple cursors/column selection 
with Alt + mouse drag.
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3 NAVIGATE CODE Windows /Linux Mac
Goto File/Function Ctrl+. Ctrl+.
Fold Selected Alt+L Cmd+Option+L
Unfold Selected Shi +Alt+L Cmd+Shi +Option+L
Fold All Alt+O Cmd+Option+O
Unfold All Shi +Alt+O Cmd+Shi +Option+O
Go to line Shi +Alt+G Cmd+Shi +Option+G
Jump to Shi +Alt+J Cmd+Shi +Option+J
Switch to tab Ctrl+Shi +. Ctrl+Shi +.
Previous tab Ctrl+F11 Ctrl+F11
Next tab Ctrl+F12 Ctrl+F12
First tab Ctrl+Shi +F11 Ctrl+Shi +F11
Last tab Ctrl+Shi +F12 Ctrl+Shi +F12
Navigate back Ctrl+F9 Cmd+F9
Navigate forward Ctrl+F10 Cmd+F10
Jump to Brace Ctrl+P Ctrl+P
Select within Braces Ctrl+Shi +Alt+E Ctrl+Shi +Option+E
Use Selection for Find Ctrl+F3 Cmd+E
Find in Files Ctrl+Shi +F Cmd+Shi +F
Find Next Win: F3, Linux: Ctrl+G Cmd+G
Find Previous W: Shi +F3, L: Cmd+Shi +G
Jump to Word Ctrl+ / Option+ /
Jump to Start/End Ctrl+ / Cmd+ /
Toggle Outline Ctrl+Shi +O Cmd+Shi +O

8 DOCUMENTS AND APPS Windows/Linux Mac
Preview HTML (Markdown, etc.) Ctrl+Shi +K Cmd+Shi +K
Knit Document (knitr) Ctrl+Shi +K Cmd+Shi +K
Compile Notebook Ctrl+Shi +K Cmd+Shi +K
Compile PDF (TeX and Sweave) Ctrl+Shi +K Cmd+Shi +K
Insert chunk (Sweave and Knitr) Ctrl+Alt+I Cmd+Option+I
Insert code section Ctrl+Shi +R Cmd+Shi +R
Re-run previous region Ctrl+Shi +P Cmd+Shi +P
Run current document Ctrl+Alt+R Cmd+Option+R
Run from start to current line Ctrl+Alt+B Cmd+Option+B
Run the current code section Ctrl+Alt+T Cmd+Option+T
Run previous Sweave/Rmd code Ctrl+Alt+P Cmd+Option+P
Run the current chunk Ctrl+Alt+C Cmd+Option+C
Run the next chunk Ctrl+Alt+N Cmd+Option+N
Sync Editor & PDF Preview Ctrl+F8 Cmd+F8

7 MAKE PACKAGES Windows/Linux Mac
Build and Reload Ctrl+Shi +B Cmd+Shi +B
Load All (devtools) Ctrl+Shi +L Cmd+Shi +L
Test Package (Desktop) Ctrl+Shi +T Cmd+Shi +T
Test Package (Web) Ctrl+Alt+F7 Cmd+Opt+F7
Check Package Ctrl+Shi +E Cmd+Shi +E
Document Package Ctrl+Shi +D Cmd+Shi +D

6 VERSION CONTROL Windows/Linux Mac
Show di Ctrl+Alt+D Ctrl+Option+D
Commit changes Ctrl+Alt+M Ctrl+Option+M
Scroll di  view Ctrl+ / Ctrl+ /
Stage/Unstage (Git) Spacebar Spacebar
Stage/Unstage and move to next Enter Enter

5 DEBUG CODE Windows/Linux Mac
Toggle Breakpoint Shi +F9 Shi +F9
Execute Next Line F10 F10
Step Into Function Shi +F4 Shi +F4
Finish Function/Loop Shi +F6 Shi +F6
Continue Shi +F5 Shi +F5
Stop Debugging Shi +F8 Shi +F8

2 RUN CODE Windows/Linux Mac
Search command history Ctrl+ Cmd+
Navigate command history / /
Move cursor to start of line Home Cmd+
Move cursor to end of line End Cmd+ 
Change working directory Ctrl+Shi +H Ctrl+Shi +H
Interrupt current command Esc Esc
Clear console Ctrl+L Ctrl+L
Quit Session (desktop only) Ctrl+Q Cmd+Q
Restart R Session Ctrl+Shi +F10 Cmd+Shi +F10
Run current line/selection Ctrl+Enter Cmd+Enter
Run current (retain cursor) Alt+Enter Option+Enter
Run from current to end Ctrl+Alt+E Cmd+Option+E
Run the current function Ctrl+Alt+F Cmd+Option+F
Source a file Ctrl+Alt+G Cmd+Option+G
Source the current file Ctrl+Shi +S Cmd+Shi +S
Source with echo Ctrl+Shi +Enter Cmd+Shi +Enter

1 LAYOUT Windows/Linux Mac
Move focus to Source Editor Ctrl+1 Ctrl+1
Move focus to Console Ctrl+2 Ctrl+2
Move focus to Help Ctrl+3 Ctrl+3
Show History Ctrl+4 Ctrl+4
Show Files Ctrl+5 Ctrl+5
Show Plots Ctrl+6 Ctrl+6
Show Packages Ctrl+7 Ctrl+7
Show Environment Ctrl+8 Ctrl+8
Show Git/SVN Ctrl+9 Ctrl+9
Show Build Ctrl+0 Ctrl+0
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Previous plot Ctrl+Alt+F11 Cmd+Option+F11
Next plot Ctrl+Alt+F12 Cmd+Option+F12
Show Keyboard Shortcuts Alt+Shi +K Option+Shi +K

RSP extends the  the open source server with a 
commercial license, support, and more:

• open and run multiple R sessions at once 
• tune your resources to improve performance 
• edit the same project at the same time as others 
• see what you and others are doing on your server 
• switch easily from one version of R to a di erent version 
• integrate with your authentication, authorization, and audit practices

Download a free 45 day evaluation at  
www.rstudio.com/products/rstudio-server-pro/

WHY RSTUDIO SERVER PRO?4 WRITE CODE Windows /Linux Mac
Attempt completion Tab or Ctrl+Space Tab or Cmd+Space
Navigate candidates / /
Accept candidate Enter, Tab, or Enter, Tab, or 
Dismiss candidates Esc Esc
Undo Ctrl+Z Cmd+Z
Redo Ctrl+Shi +Z Cmd+Shi +Z
Cut Ctrl+X Cmd+X
Copy Ctrl+C Cmd+C
Paste Ctrl+V Cmd+V
Select All Ctrl+A Cmd+A
Delete Line Ctrl+D Cmd+D
Select Shi +[Arrow] Shi +[Arrow]
Select Word Ctrl+Shi + / Option+Shi + /
Select to Line Start Alt+Shi + Cmd+Shi +
Select to Line End Alt+Shi + Cmd+Shi +
Select Page Up/Down Shi +PageUp/Down Shi +PageUp/Down
Select to Start/End Shi +Alt+ / Cmd+Shi + /
Delete Word Le Ctrl+Backspace Ctrl+Opt+Backspace
Delete Word Right Option+Delete
Delete to Line End Ctrl+K
Delete to Line Start Option+Backspace
Indent Tab (at start of line) Tab (at start of line)
Outdent Shi +Tab Shi +Tab
Yank line up to cursor Ctrl+U Ctrl+U
Yank line a er cursor Ctrl+K Ctrl+K
Insert yanked text Ctrl+Y Ctrl+Y
Insert <- Alt+- Option+-
Insert %>% Ctrl+Shi +M Cmd+Shi +M
Show help for function F1 F1
Show source code F2 F2
New document Ctrl+Shi +N Cmd+Shi +N
New document (Chrome) Ctrl+Alt+Shi +N Cmd+Shi +Opt+N
Open document Ctrl+O Cmd+O
Save document Ctrl+S Cmd+S
Close document Ctrl+W Cmd+W
Close document (Chrome) Ctrl+Alt+W Cmd+Option+W
Close all documents Ctrl+Shi +W Cmd+Shi +W
Extract function Ctrl+Alt+X Cmd+Option+X
Extract variable Ctrl+Alt+V Cmd+Option+V
Reindent lines Ctrl+I Cmd+I
(Un)Comment lines Ctrl+Shi +C Cmd+Shi +C
Reflow Comment Ctrl+Shi +/ Cmd+Shi +/
Reformat Selection Ctrl+Shi +A Cmd+Shi +A
Select within braces Ctrl+Shi +E Ctrl+Shi +E
Show Diagnostics Ctrl+Shi +Alt+P Cmd+Shi +Opt+P
Transpose Letters Ctrl+T
Move Lines Up/Down Alt+ / Option+ /
Copy Lines Up/Down Shi +Alt+ / Cmd+Option+ /
Add New Cursor Above Ctrl+Alt+Up Ctrl+Option+Up
Add New Cursor Below Ctrl+Alt+Down Ctrl+Option+Down
Move Active Cursor Up Ctrl+Alt+Shi +Up Ctrl+Option+Shi +Up
Move Active Cursor Down Ctrl+Alt+Shi +Down Ctrl+Opt+Shi +Down
Find and Replace Ctrl+F Cmd+F
Use Selection for Find Ctrl+F3 Cmd+E
Replace and Find Ctrl+Shi +J Cmd+Shi +J



Shiny : : CHEAT SHEET 
Complete the template by adding arguments to fluidPage() and a 
body to the server function.

app-name
app.R

�

DESCRIPTION
README
<other files>
www

�
�
�

�.r

library(shiny) 

ui <- fluidPage( 
  numericInput(inputId = "n",  
    "Sample size", value = 25), 
  plotOutput(outputId = "hist") 
) 

server <- function(input, output) { 
  output$hist <- renderPlot({ 
    hist(rnorm(input$n)) 
  }) 
} 

shinyApp(ui = ui, server = server)

Add inputs to the UI with *Input() functions 

Add outputs with *Output() functions 

Tell server how to render outputs with R in  
the server function. To do this: 
1. Refer to outputs with output$<id> 
2. Refer to inputs with input$<id> 
3. Wrap code in a render*() function before 

saving to output

Save your template as app.R. Alternatively, split your template into two files named ui.R and server.R.

library(shiny) 
ui <- fluidPage( 
  numericInput(inputId = "n",  
    "Sample size", value = 25), 
  plotOutput(outputId = "hist") 
) 
server <- function(input, output) { 
  output$hist <- renderPlot({ 
    hist(rnorm(input$n)) 
  }) 
} 
shinyApp(ui = ui, server = server)

# ui.R 
fluidPage( 
  numericInput(inputId = "n",  
    "Sample size", value = 25), 
  plotOutput(outputId = "hist") 
)

# server.R 
function(input, output) { 
  output$hist <- renderPlot({ 
    hist(rnorm(input$n)) 
  }) 
}

ui.R contains everything  
you would save to ui. 

server.R ends with the 
function you would save  

to server. 

No need to call  
shinyApp(). 

Save each app as a directory that holds an app.R file (or a server.R file and a ui.R file) plus optional extra files.
The directory name is the name of the app 
(optional) defines objects available to both  
ui.R and server.R 
(optional) used in showcase mode 
(optional) data, scripts, etc. 
(optional) directory of files to share with web 
 browsers (images, CSS, .js, etc.) Must be named "www"

Launch apps with 
runApp(<path to 

directory>)

global.R�

Basics Building an App 

Outputs - render*()  and *Output() functions work together to add R output to the UI

Inputs
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Build or purchase your own Shiny Server  
at www.rstudio.com/products/shiny-server/

A Shiny app is a web page (UI) connected to a 
computer running a live R session (Server)

Users can manipulate the UI, which will cause 
the server to update the UI’s displays (by 
running R code).

library(shiny) 
ui <- fluidPage() 

server <- function(input, output){} 
shinyApp(ui = ui, server = server)

Begin writing a new app with this template. 
Preview the app by running the code at the R 
command line.

The easiest way to share your app 
is to host it on shinyapps.io, a 
cloud based service from RStudio

1. Create a free or professional account at 
 http://shinyapps.io 

2. Click the Publish icon in the RStudio IDE 
or run: 
rsconnect::deployApp("<path to directory>")

• ui - nested R functions that assemble an 
HTML user interface for your app 

• server - a function with instructions on how  
to build and rebuild the R objects displayed 
in the UI 

• shinyApp - combines ui and server into 
an app. Wrap with runApp() if calling from a 
sourced script or inside a function.

APP TEMPLATE

SHARE YOUR APP

DT::renderDataTable(expr, options,   
callback,  escape, env, quoted) 

renderImage(expr, env, quoted, 
deleteFile) 

renderPlot(expr, width, height, res, …, 
env, quoted, func) 

renderPrint(expr, env, quoted, func,  
width) 

renderTable(expr,…, env, quoted, func) 

renderText(expr, env, quoted, func) 

renderUI(expr, env, quoted, func)

dataTableOutput(outputId, icon, …) 

imageOutput(outputId, width, height, 
click, dblclick, hover, hoverDelay, inline, 
hoverDelayType, brush, clickId, hoverId) 

plotOutput(outputId, width, height, click, 
dblclick, hover, hoverDelay, inline, 
hoverDelayType, brush, clickId, hoverId) 

verbatimTextOutput(outputId) 

tableOutput(outputId) 

textOutput(outputId, container, inline) 
uiOutput(outputId, inline, container, …) 
htmlOutput(outputId, inline, container, …)

&

works 
with

collect values from the user

actionButton(inputId, label, icon, 
…) 

actionLink(inputId, label, icon, …) 

checkboxGroupInput(inputId, label, 
choices, selected, inline) 

checkboxInput(inputId, label, 
value) 

dateInput(inputId, label, value, min, 
max, format, startview, weekstart, 
language) 

dateRangeInput(inputId, label, 
start, end, min, max, format, 
startview, weekstart, language, 
separator) 

fileInput(inputId, label, multiple, 
accept) 

numericInput(inputId, label, value, 
min, max, step) 

passwordInput(inputId, label, 
value) 

radioButtons(inputId, label, 
choices, selected, inline) 

selectInput(inputId, label, choices, 
selected, multiple, selectize, width, 
size) (also selectizeInput()) 

sliderInput(inputId, label, min, max, 
value, step, round, format, locale, 
ticks, animate, width, sep, pre, 
post) 

submitButton(text, icon) 
(Prevents reactions across entire app) 

textInput(inputId, label, value)

Access the current value of an input object with 
input$<inputId>. Input values are reactive.



wellPanel(dateInput("a", ""), 
          submitButton() 
)

Reactivity
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Reactive values work together with reactive functions. Call a reactive value from within the arguments of one 
of these functions to avoid the error Operation not allowed without an active reactive context.

# example snippets 

ui <- fluidPage( 
 textInput("a","","A") 
) 

server <- 
function(input,output){ 
 rv <- reactiveValues() 
 rv$number <- 5 
}

library(shiny) 
ui <- fluidPage( 
 textInput("a","","A"), 
 textOutput("b") 
) 

server <- 
function(input,output){ 
 output$b <-   
  renderText({ 
   isolate({input$a}) 
  }) 
} 

shinyApp(ui, server)

library(shiny) 
ui <- fluidPage( 
 textInput("a","","A"), 
 textOutput("b") 
) 

server <- 
function(input,output){ 
 output$b <-   
  renderText({ 
   input$a 
  }) 
} 

shinyApp(ui, server)

library(shiny) 
ui <- fluidPage( 
 textInput("a","","A"), 
 actionButton("go","Go") 
) 

server <- 
function(input,output){  
 observeEvent(input$go,{ 
   print(input$a) 
  }) 
} 

shinyApp(ui, server)

library(shiny) 
ui <- fluidPage( 
 textInput("a","","A"), 
 actionButton("go","Go"), 
 textOutput("b") 
) 

server <- 
function(input,output){  
 re <- eventReactive( 
  input$go,{input$a}) 
 output$b <- renderText({ 
   re() 
  }) 
} 

shinyApp(ui, server)

ui <- fluidPage( 
 textInput("a","","A"), 
 textInput("z","","Z"), 
 textOutput("b")) 

server <- 
function(input,output){  
 re <- reactive({ 
  
paste(input$a,input$z)}) 
 output$b <- renderText({ 
   re() 
  }) 
} 
shinyApp(ui, server)

render*() functions 
(see front page)

observeEvent(eventExpr
, handlerExpr, event.env, 
event.quoted, handler.env, 
handler.quoted, labe, 
suspended, priority, domain, 
autoDestroy, ignoreNULL)

eventReactive(eventExpr, 
valueExpr, event.env, 
event.quoted, value.env, 
value.quoted, label, 
domain, ignoreNULL)

*Input() functions 
(see front page) 

reactiveValues(…)

isolate(expr)

reactive(x, env, quoted, 
label, domain)

Each input function 
creates a reactive value 
stored as input$<inputId> 

reactiveValues() creates a 
list of reactive values 
whose values you can set.

Builds an object to 
display. Will rerun code in 
body to rebuild the object 
whenever a reactive value 
in the code changes.  

Save the results to  
output$<outputId>

Runs a code block. 
Returns a non-reactive 
copy  of the results.

Runs code in 2nd 
argument when reactive 
values in 1st argument 
change. See observe() for 
alternative.

Creates a reactive expression 
that 
• caches its value to reduce 

computation 
• can be called by other code 
• notifies its dependencies 

when it ha been invalidated 
Call the expression with 
function syntax, e.g. re()

Creates reactive 
expression with code in 
2nd argument that only 
invalidates when reactive 
values in 1st argument 
change.

CREATE YOUR OWN REACTIVE VALUES

PREVENT REACTIONS

MODULARIZE REACTIONS

RENDER REACTIVE OUTPUT

TRIGGER ARBITRARY CODE

DELAY REACTIONS

UI - An app’s UI is an HTML document. Layouts

Add static HTML elements with tags, a list of 
functions that parallel common HTML tags, e.g. 
tags$a(). Unnamed arguments will be passed 
into the tag; named arguments will become tag 
attributes.

Use Shiny’s functions to assemble this HTML with R.

tags$a           
tags$abbr        
tags$address     
tags$area        
tags$article 
tags$aside       
tags$audio       
tags$b           
tags$base        
tags$bdi 
tags$bdo         
tags$blockquote  
tags$body        
tags$br          
tags$button 
tags$canvas      
tags$caption     
tags$cite        
tags$code   
tags$col  
tags$colgroup    
tags$command  

tags$data        
tags$datalist    
tags$dd 
tags$del         
tags$details     
tags$dfn         
tags$div         
tags$dl 
tags$dt          
tags$em          
tags$embed       
tags$eventsource 
tags$fieldset 
tags$figcaption  
tags$figure      
tags$footer      
tags$form  
tags$h1  
tags$h2          
tags$h3   
tags$h4          
tags$h5    

tags$h6 
tags$head        
tags$header      
tags$hgroup      
tags$hr          
tags$HTML 
tags$i           
tags$iframe      
tags$img     
tags$input        
tags$ins 
tags$kbd         
tags$keygen  
tags$label       
tags$legend      
tags$li 
tags$link        
tags$mark        
tags$map         
tags$menu   
tags$meta 
tags$meter       

tags$nav         
tags$noscript    
tags$object      
tags$ol 
tags$optgroup    
tags$option  
tags$output      
tags$p           
tags$param 
tags$pre         
tags$progress   
tags$q           
tags$ruby        
tags$rp 
tags$rt          
tags$s           
tags$samp        
tags$script      
tags$section     
tags$select      
tags$small  
tags$source      
     

tags$span        
tags$strong 
tags$style       
tags$sub  
tags$summary     
tags$sup         
tags$table 
tags$tbody       
tags$td   
tags$textarea    
tags$tfoot       
tags$th 
tags$thead       
tags$time        
tags$title       
tags$tr          
tags$track 
tags$u           
tags$ul          
tags$var         
tags$video       
tags$wbr

fluidPage( 
  textInput("a","") 
) 
## <div class="container-fluid"> 
##  <div class="form-group shiny-input-container"> 
##     <label for="a"></label> 
##     <input id="a" type="text"  
##        class="form-control" value=""/> 
##   </div> 
## </div> 

Returns  
HTML

The most common tags have wrapper functions. You 
do not need to prefix their names with tags$

To include a CSS file, use includeCSS(), or 
1. Place the file in the www subdirectory 
2. Link to it with 

To include JavaScript, use includeScript() or 
1. Place the file in the www subdirectory 
2. Link to it with 

tags$head(tags$link(rel = "stylesheet",  
  type = "text/css", href = "<file name>"))

tags$head(tags$script(src = "<file name>"))

To include an image 
1. Place the file in the www subdirectory 
2. Link to it with  img(src="<file name>")

Combine multiple elements 
into a "single element" that 
has its own properties with 
a panel function, e.g.

fluidRow()

row

column

column col

flowLayout()
object 

1
object 

2
object 
3

object 3

splitLayout()

object 
1

object 
2

Organize panels and elements into a layout with a 
layout function. Add elements as arguments of the  

layout functions. 

Layer tabPanels on top of each other, 
and navigate between them, with:

side 
panel

main 
panel

sidebarLayout()

verticalLayout()
object 1

object 2

object 3

ui <- fluidPage( 
  fluidRow(column(width = 4),  
      column(width = 2,  offset = 3)), 
  fluidRow(column(width = 12)) 
) 

ui <- fluidPage( 
  flowLayout( # object 1, 
                             # object 2, 
                             # object 3 
  ) 
) 

ui <- fluidPage( 
   sidebarLayout( 
      sidebarPanel(), 
      mainPanel() 
   ) 
) 

ui <- fluidPage( 
  splitLayout( # object 1, 
                             # object 2 
  ) 
) 

ui <- fluidPage( 
  verticalLayout( # object 1, 
                                    # object 2, 
                                    # object 3 
  ) 
) 

ui <- fluidPage( tabsetPanel( 
     tabPanel("tab 1", "contents"), 
     tabPanel("tab 2", "contents"), 
     tabPanel("tab 3", "contents")))

ui <- fluidPage( navlistPanel( 
     tabPanel("tab 1", "contents"), 
     tabPanel("tab 2", "contents"), 
     tabPanel("tab 3", "contents")))

ui <- navbarPage(title = "Page", 
     tabPanel("tab 1", "contents"), 
     tabPanel("tab 2", "contents"), 
     tabPanel("tab 3", "contents"))

absolutePanel()     
conditionalPanel()     
fixedPanel()  
headerPanel()        
inputPanel()        
mainPanel()  

navlistPanel() 
sidebarPanel() 
tabPanel() 
tabsetPanel() 
titlePanel() 
wellPanel()

IMAGES

ui <- fluidPage( 
  h1("Header 1"),  
  hr(), 
  br(), 
  p(strong("bold")), 
  p(em("italic")), 
  p(code("code")), 
  a(href="", "link"), 
  HTML("<p>Raw html</p>") 
)



One or more lines surrounded with ```{r} and ```. Place chunk 
options within curly braces, after r. Insert with

YAML Header  
Optional section of render (e.g. pandoc)  
options written as key:value pairs (YAML). 
At start of file 
Between lines of  - - -  
Text 
Narration formatted with markdown, mixed with: 
Code Chunks 
Chunks of embedded code. Each chunk: 
Begins with ```{r} 
ends with ``` 
R Markdown will run the code and append the results to the doc. 
It will use the location of the .Rmd file  as the working directory

Interactive 
Documents
Turn your report into an interactive Shiny  
document in 4 steps 
1. Add runtime: shiny to the YAML header. 
2. Call Shiny input functions to embed input objects. 
3. Call Shiny render functions to embed reactive output. 
4. Render with rmarkdown::run  or click Run Document in 
RStudio IDE

--- 
output: html_document 
runtime: shiny 
--- 

```{r, echo = FALSE} 
numericInput("n",    
  "How many cars?", 5) 

renderTable({ 
  head(cars, input$n) 
}) 
```

Embed a complete app into your document with 
shiny::shinyAppDir() 
NOTE: Your report will rendered as a Shiny app, which means 
you must choose an html output format, like html_document, 
and serve it with an active R Session.
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R Markdown : : CHEAT SHEET 

Open a new .Rmd file at File ▶ New File ▶  
R Markdown. Use the wizard that opens  to pre-
populate the file with a template 
Write document by editing template 

Knit document to create report; use knit button or 
render() to knit 

Preview Output in IDE window 

Publish (optional) to web server 
Examine build log in R Markdown console 

Use output file that is saved along side .Rmd

1

2
3

4
5
6
7

modify 
chunk 
options

run all 
previous 
chunks

run 
current 
chunk

insert 
code 
chunk go to 

code 
chunk

run code 
chunk(s)

1

2

3 4

5

6

7

publish

show 
outline

synch publish 
button to 
accounts at 
rpubs.com, 
shinyapps.io  
RStudio  
Connect

Reload document

Find in document

File path to output document

set 
preview 
location

What is R Markdown?

Insert with `r <code>`. Results appear as text without code.

Options not listed above: R.options, aniopts, autodep, background, cache.comments, cache.lazy, cache.rebuild, cache.vars, dev, dev.args, dpi, 
engine.opts, engine.path, fig.asp, fig.env, fig.ext, fig.keep, fig.lp, fig.path, fig.pos, fig.process, fig.retina, fig.scap, fig.show, fig.showtext, fig.subcap, interval, 
out.extra, out.height, out.width, prompt, purl, ref.label, render, size, split, tidy.opts

Embed code with knitr syntax
Built with `r getRversion()`                Built with 3.2.3

INLINE CODE CODE CHUNKS

```{r echo=TRUE}  
getRversion() 
```

Set with knitr::opts_chunk$set(), e.g.
GLOBAL OPTIONS

```{r include=FALSE}  
knitr::opts_chunk$set(echo = TRUE) 
```

Use rmarkdown::render() to render/knit at cmd line. Important args:

Workflow

input - file to render 
output_format

render

Parameters
Parameterize your documents to reuse with 
different inputs (e.g., data, values, etc.)

--- 
params:  
  n: 100 
  d: !r Sys.Date() 
---

Today’s date  
is `r params$d`

1. Add parameters · Create and set 
parameters in the header as sub-
values of params 

2. Call parameters · Call parameter 
values in code as params$<name> 

3. Set parameters · Set values wth 
Knit with parameters or the params 
argument of render(): 
render("doc.Rmd", params = list(n = 1, 
d = as.Date("2015-01-01")) 

output_options -  
List of render  
options (as in YAML)

output_file  
output_dir 

params - list of 
params to use

envir - environment  
to evaluate code 
chunks in

encoding - of input 
file

.rmd Structure
.Rmd files · An R Markdown  
(.Rmd) file is a record of your  
research. It contains the code that a 
scientist needs to reproduce your work 
along with the narration that a reader 
needs to understand your work. 
Reproducible Research · At the click of a 
button, or the type of a command, you 
can rerun the code in an R Markdown file 
to reproduce your work and export the 
results as a finished report. 
Dynamic Documents · You can choose 
to export the finished report in a variety 
of formats, including html, pdf, MS 
Word, or RTF documents; html or pdf 
based slides, Notebooks, and more.

cache - cache results for future knits (default = 
FALSE) 
cache.path - directory to save cached results in 
(default = "cache/") 
child - file(s) to knit and then include (default = 
NULL) 
collapse - collapse all output into single block 
(default = FALSE) 
comment - prefix for each line of results (default = '##')

dependson - chunk dependencies for caching 
(default = NULL) 
echo - Display code in output document (default = 
TRUE) 
engine - code language used in chunk (default = 
'R') 
error - Display error messages in doc (TRUE) or 
stop render when errors occur (FALSE) (default = 
FALSE) 
eval - Run code in chunk (default = TRUE)

message - display code messages in  
document (default = TRUE) 
results  (default = 'markup') 
'asis' - passthrough results 
'hide' - do not display results 
'hold' - put all results below all code 
tidy - tidy code for display (default = FALSE) 
warning - display code warnings in document 
(default = TRUE)

fig.align - 'left', 'right', or 'center' (default = 
'default') 
fig.cap - figure caption as character string (default 
= NULL) 
fig.height, fig.width - Dimensions of plots in 
inches 
highlight - highlight source code (default = TRUE) 
include - Include chunk in doc after running 
(default = TRUE)

IMPORTANT CHUNK OPTIONS

rmarkdown

Rmd



```{r results = 'asis'} 
knitr::kable(data, caption = "Table with kable”) 
``` 
```{r results = "asis"} 
print(xtable::xtable(data, caption = "Table with xtable”),  
            type = "html", html.table.attributes = "border=0")) 
``` 
```{r results = "asis"}  
stargazer::stargazer(data, type = "html", title = "Table  
                                            with stargazer") 
```

Plain text   
End a line with two spaces  
to start a new paragraph.   
*italics* and **bold**   
`verbatim code`   
sub/superscript^2^~2~   
~~strikethrough~~   
escaped: \* \_ \\   
endash: --, emdash: ---   
equation: $A = \pi*r^{2}$   
equation block: 

$$E = mc^{2}$$ 

> block quote   

# Header1  {#anchor} 

## Header 2  {#css_id} 

### Header 3  {.css_class} 

#### Header 4   

##### Header 5   

###### Header 6   

<!--Text comment--> 

\textbf{Tex ignored in HTML} 
<em>HTML ignored in pdfs</em>  

<http://www.rstudio.com>   
[link](www.rstudio.com)   
Jump to [Header 1](#anchor)   
image:  

![Caption](smallorb.png) 

* unordered list 
    + sub-item 1 
    + sub-item 2 
        - sub-sub-item 1 
   
* item 2 

    Continued (indent 4 spaces) 
     
1. ordered list 
2. item 2 
    i) sub-item 1 
         A.  sub-sub-item 1 

(@)  A list whose numbering 

continues after 

(@)  an interruption 

Term 1 

:   Definition 1 

| Right | Left | Default | Center | 
|------:|:-----|---------|:------:| 
|   12  |  12  |    12   |    12  | 
|  123  |  123 |   123   |   123  | 
|    1  |    1 |     1   |     1  | 

- slide bullet 1 
- slide bullet 2   

(>- to have bullets appear on click) 

horizontal rule/slide break:  

*** 

A footnote [^1] 

[^1]: Here is the footnote. 

Write with syntax on the left to create effect on right (after render)
Pandoc’s Markdown Set render options with YAML

When you render, R Markdown  
1. runs the R code, embeds results and text into .md file with knitr  
2. then converts the .md file into the finished format with pandoc

Create a Reusable Template
1. Create a new package with a inst/rmarkdown/templates 
directory 
2. In the directory, Place a folder that contains: 
template.yaml (see below) 
skeleton.Rmd (contents of the template) 
any supporting files 
3. Install the package 
4. Access template in wizard at File ▶ New File ▶ R Markdown  
template.yaml

Set a document’s 
default output format 
in the YAML header:

--- 
output: html_document 
--- 
# Body

output value creates
html_document html
pdf_document pdf (requires Tex )
word_document Microsoft Word (.docx)
odt_document OpenDocument Text
rtf_document Rich Text Format
md_document Markdown
github_document Github compatible markdown
ioslides_presentation ioslides HTML slides
slidy_presentation slidy HTML slides
beamer_presentation Beamer pdf slides (requires Tex)

Customize output with 
sub-options (listed to 
the right):

--- 
output: html_document: 
  code_folding: hide 
  toc_float: TRUE 
--- 
# Body

Indent 4 
spaces

Indent 2 
spaces

html tabsets 
Use tablet css class to place sub-headers into tabs

# Tabset {.tabset .tabset-fade .tabset-pills} 
## Tab 1 
text 1 
## Tab 2 
text 2 
### End tabset

Tabset 

text 1 
End tabset

  Tab 1   Tab 2

--- 
name: My Template 
—

sub-option description
citation_package The LaTeX package to process citations, natbib, biblatex or none X X X
code_folding Let readers to toggle the display of R code, "none", "hide", or "show" X
colortheme Beamer color theme to use X
css CSS file to use to style document X X X
dev Graphics device to use for figure output (e.g. "png") X X X X X X X
duration Add a countdown timer (in minutes) to footer of slides X
fig_caption Should figures be rendered with captions? X X X X X X X
fig_height, fig_width Default figure height and width  (in inches) for document X X X X X X X X X X
highlight Syntax highlighting: "tango", "pygments", "kate","zenburn", "textmate" X X X X X
includes File of content to place in document (in_header, before_body, after_body) X X X X X X X X
incremental Should bullets appear one at a time (on presenter mouse clicks)? X X X
keep_md Save a copy of .md file that contains knitr output X X X X X X
keep_tex Save a copy of .tex file that contains knitr output X X
latex_engine Engine to render latex, "pdflatex", "xelatex", or "lualatex" X X
lib_dir Directory of dependency files to use (Bootstrap, MathJax, etc.) X X X
mathjax Set to local or a URL to use a local/URL version of MathJax to render equations X X X
md_extensions Markdown extensions to add to default definition or R Markdown X X X X X X X X X X
number_sections Add section numbering to headers X X
pandoc_args Additional arguments to pass to Pandoc X X X X X X X X X X
preserve_yaml Preserve YAML front matter in final document? X
reference_docx docx file whose styles should be copied when producing docx output X
self_contained Embed dependencies into the doc X X X
slide_level The lowest heading level that defines individual slides X
smaller Use the smaller font size in the presentation? X
smart Convert straight quotes to curly, dashes to em-dashes, … to ellipses, etc. X X X
template Pandoc template to use when rendering file quarterly_report.html). X X X X X
theme Bootswatch or Beamer theme to use for page X X
toc Add a table of contents at start of document X X X X X X X
toc_depth The lowest level of headings to add to table of contents X X X X X X
toc_float Float the table of contents to the left of the main content X
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Table Suggestions Citations and Bibliographies
Several functions format R data into tables

Learn more in  
the stargazer, 

xtable, and knitr 
packages.

Create citations with .bib, .bibtex, .copac, .enl, .json,  
.medline, .mods, .ris, .wos, and .xml files 

1. Set bibliography file and CSL 1.0  
Style file (optional) in the YAML header 

2.  Use citation keys in text 

3.  Render. Bibliography will be  
added to end of document

Smith cited [@smith04]. 
Smith cited without author [-@smith04]. 
@smith04 cited in line.

--- 
bibliography: refs.bib  
csl: style.csl 
---

data <- faithful[1:4, ]
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read_*(file, col_names = TRUE, col_types = NULL, locale = default_locale(), na = c("", "NA"), 
quoted_na = TRUE, comment = "", trim_ws = TRUE, skip = 0, n_max = Inf, guess_max = min(1000, 
n_max), progress = interactive())

Try one of the following packages to import 
other types of files 

• haven - SPSS, Stata, and SAS files 
• readxl - excel files (.xls and .xlsx) 
• DBI - databases 
• jsonlite - json 
• xml2 - XML 
• httr - Web APIs 
• rvest - HTML (Web Scraping)

Save Data

Data Import : : CHEAT SHEET 
Read Tabular Data - These functions share the common arguments: Data types

USEFUL ARGUMENTS

OTHER TYPES OF DATA

Comma delimited file 
write_csv(x, path, na = "NA", append = FALSE, 

col_names = !append) 
File with arbitrary delimiter 

write_delim(x, path, delim = " ", na = "NA", 
append = FALSE, col_names = !append) 

CSV for excel 
write_excel_csv(x, path, na = "NA", append = 

FALSE, col_names = !append) 
String to file 

write_file(x, path, append = FALSE) 
String vector to file, one element per line 

write_lines(x,path, na = "NA", append = FALSE) 
Object to RDS file 

write_rds(x, path, compress = c("none", "gz", 
"bz2", "xz"), ...) 

Tab delimited files 
write_tsv(x, path, na = "NA", append = FALSE, 

col_names = !append)

Save x, an R object, to path, a file path, as:

Skip lines 
read_csv(f, skip = 1) 
  

Read in a subset 
read_csv(f, n_max = 1) 

  
Missing Values 
read_csv(f, na = c("1", "."))

Comma Delimited Files 
read_csv("file.csv") 

To make file.csv run:  
write_file(x = "a,b,c\n1,2,3\n4,5,NA", path = "file.csv") 

Semi-colon Delimited Files 
read_csv2("file2.csv") 

write_file(x = "a;b;c\n1;2;3\n4;5;NA", path = "file2.csv") 

Files with Any Delimiter  
read_delim("file.txt", delim = "|") 

write_file(x = "a|b|c\n1|2|3\n4|5|NA", path = "file.txt") 

Fixed Width Files 
read_fwf("file.fwf", col_positions = c(1, 3, 5))  

write_file(x = "a b c\n1 2 3\n4 5 NA", path = "file.fwf") 

Tab Delimited Files 
read_tsv("file.tsv") Also read_table(). 

write_file(x = "a\tb\tc\n1\t2\t3\n4\t5\tNA", path = "file.tsv")

a,b,c 
1,2,3 
4,5,NA

a;b;c 
1;2;3 
4;5;NA

a|b|c 
1|2|3 
4|5|NA

a  b  c 
1  2  3 
4  5  NA

A B C
1 2 3

A B C
1 2 3
4 5 NA

x y z
A B C
1 2 3
4 5 NA

A B C
NA 2 3
4 5 NA

1 2 3

4 5 NA

A B C
1 2 3
4 5 NA

A B C
1 2 3
4 5 NA

A B C
1 2 3
4 5 NA

A B C
1 2 3
4 5 NA

a,b,c 
1,2,3 
4,5,NA

Example file 
write_file("a,b,c\n1,2,3\n4,5,NA","file.csv") 
f <- "file.csv" 

No header 
read_csv(f, col_names = FALSE) 

Provide header 
read_csv(f, col_names = c("x", "y", "z"))

Read a file into a single string 
read_file(file, locale = default_locale()) 

Read each line into its own string 
read_lines(file, skip = 0, n_max = -1L, na = character(), 

locale = default_locale(), progress = interactive())

Read a file into a raw vector 
read_file_raw(file) 

Read each line into a raw vector 
read_lines_raw(file, skip = 0, n_max = -1L, 

progress = interactive())

Read Non-Tabular Data

Read Apache style log files 
read_log(file, col_names = FALSE, col_types = NULL, skip = 0, n_max = -1, progress = interactive())

## Parsed with column specification: 
## cols( 
##   age = col_integer(), 
##   sex = col_character(), 
##   earn = col_double() 
## )

1. Use problems() to diagnose problems. 
x <- read_csv("file.csv"); problems(x) 

2. Use a col_ function to guide parsing. 
• col_guess() - the default 
• col_character() 
• col_double(), col_euro_double() 
• col_datetime(format = "") Also  

col_date(format = ""), col_time(format = "") 
• col_factor(levels, ordered = FALSE) 
• col_integer() 
• col_logical() 
• col_number(), col_numeric() 
• col_skip() 
x <- read_csv("file.csv", col_types = cols( 
    A = col_double(), 
    B = col_logical(), 
    C = col_factor())) 

3. Else, read in as character vectors then parse 
with a parse_ function. 

• parse_guess() 
• parse_character() 
• parse_datetime() Also parse_date() and 

parse_time() 
• parse_double() 
• parse_factor() 
• parse_integer() 
• parse_logical() 
• parse_number() 
x$A <- parse_number(x$A)

readr functions guess  
the types of each column and  
convert types when appropriate (but will NOT 
convert strings to factors automatically).  

A message shows the type of each column in the 
result.

earn is a double (numeric)
sex is a 

character

age is an 
integer
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R’s tidyverse is built around tidy data stored 
in  tibbles, which are enhanced data frames.  

The front side of this sheet shows 
how to read text files into R with 
readr. 

The reverse side shows how to 
create tibbles with tibble and to 
layout tidy data with tidyr. 



separate_rows(data, ..., sep = "[^[:alnum:].]
+", convert = FALSE) 
Separate each cell in a column to make 
several rows. Also separate_rows_().

Handle Missing Values

Reshape Data - change the layout of values in a table

gather(data, key, value, ..., na.rm = FALSE,  
convert = FALSE, factor_key = FALSE) 
gather() moves column names into a key 
column, gathering the column values into a 
single value column.

spread(data, key, value, fill = NA, convert = FALSE, 
drop = TRUE, sep = NULL) 
spread() moves the unique values of a key 
column into the column names, spreading the 
values of a value column across the new columns.

Use gather() and spread() to reorganize the values of a table into a new layout.

gather(table4a, `1999`, `2000`,  
key = "year", value = "cases") spread(table2, type, count)

valuekey

table4a
country 1999 2000

A 0.7K 2K
B 37K 80K
C 212K 213K

country year cases
A 1999 0.7K
B 1999 37K
C 1999 212K
A 2000 2K
B 2000 80K
C 2000 213K

valuekey

country year cases pop
A 1999 0.7K 19M
A 2000 2K 20M
B 1999 37K 172M
B 2000 80K 174M
C 1999 212K 1T
C 2000 213K 1T

table2
country year type count

A 1999 cases 0.7K
A 1999 pop 19M
A 2000 cases 2K
A 2000 pop 20M
B 1999 cases 37K
B 1999 pop 172M
B 2000 cases 80K
B 2000 pop 174M
C 1999 cases 212K
C 1999 pop 1T
C 2000 cases 213K
C 2000 pop 1T

unite(data, col, ..., sep = "_", remove = TRUE) 
Collapse cells across several columns to 
make a single column.

drop_na(data, ...) 
Drop rows containing 
NA’s in … columns.

fill(data, ..., .direction = c("down", "up")) 
Fill in NA’s in … columns with most 
recent non-NA values.

replace_na(data,  
replace = list(), ...) 
Replace NA’s by column.

Use these functions to 
split or combine cells 
into individual, isolated 
values.

country year rate
A 1999 0.7K/19M
A 2000 2K/20M
B 1999 37K/172M
B 2000 80K/174M
C 1999 212K/1T
C 2000 213K/1T

country year cases pop
A 1999 0.7K 19M
A 2000 2K 20M
B 1999 37K 172
B 2000 80K 174
C 1999 212K 1T
C 2000 213K 1T

table3

separate(data, col, into,  sep = "[^[:alnum:]]
+", remove = TRUE, convert = FALSE,  
extra = "warn", fill = "warn", ...) 
Separate each cell in a column to make 
several columns.

country century year
Afghan 19 99
Afghan 20 0
Brazil 19 99
Brazil 20 0
China 19 99
China 20 0

country year
Afghan 1999
Afghan 2000
Brazil 1999
Brazil 2000
China 1999
China 2000

table5

separate(table3, rate,  
into = c("cases", "pop"))

separate_rows(table3, rate)

unite(table5, century, year,  
col = "year", sep = "")

x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
D 3

x
x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
B 1
C 1
D 3
E 3

x
x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
B 2
C 2
D 3
E 2

x

drop_na(x, x2) fill(x, x2) replace_na(x, list(x2 = 2))

country year rate
A 1999 0.7K
A 1999 19M
A 2000 2K
A 2000 20M
B 1999 37K
B 1999 172M
B 2000 80K
B 2000 174M
C 1999 212K
C 1999 1T
C 2000 213K
C 2000 1T

table3
country year rate

A 1999 0.7K/19M
A 2000 2K/20M
B 1999 37K/172M
B 2000 80K/174M
C 1999 212K/1T
C 2000 213K/1T

Tidy data is a way to organize tabular data. It provides a consistent data structure across packages.

CBA
A * B -> C
*A B C

Each observation, or 
case,  is in its own row

A B C

Each variable is in 
its own column

A B C

&
A table is tidy if: Tidy data:

Makes variables easy 
to access as vectors

Preserves cases during 
vectorized operations

complete(data, ..., fill = list()) 
Adds to the data missing combinations of the 
values of the variables listed in …   
complete(mtcars, cyl, gear, carb)

expand(data, ...) 
Create new tibble with all possible combinations 
of the values of the variables listed in …   
expand(mtcars, cyl, gear, carb)

The tibble package provides a new  
S3 class for storing tabular data, the  
tibble. Tibbles inherit the data frame  
class, but improve three behaviors: 

• Subsetting - [ always returns a new tibble, 
[[ and $ always return a vector. 

• No partial matching - You must use full  
column names when subsetting 

• Display - When you print a tibble, R provides a  
concise view of the  
data that fits on  
one screen
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Tibbles - an enhanced data frame Split Cells

• Control the default appearance with options: 
options(tibble.print_max = n, 

tibble.print_min = m, tibble.width = Inf) 

• View full data set with View() or glimpse() 
• Revert to data frame with as.data.frame()

data frame display

tibble display

tibble(…)  
Construct by columns. 
tibble(x = 1:3, y = c("a", "b", "c")) 

tribble(…)  
Construct by rows. 
tribble( ~x,     ~y, 
                   1,    "a", 
                   2,    "b", 
                   3,    "c")

A tibble: 3 × 2 
      x     y 
  <int> <chr> 
1     1     a 
2     2     b 
3     3     c

Both  
make this 

 tibble

ww

# A tibble: 234 × 6 
   manufacturer      model displ 
          <chr>      <chr> <dbl> 
1          audi         a4   1.8 
2          audi         a4   1.8 
3          audi         a4   2.0 
4          audi         a4   2.0 
5          audi         a4   2.8 
6          audi         a4   2.8 
7          audi         a4   3.1 
8          audi a4 quattro   1.8 
9          audi a4 quattro   1.8 
10         audi a4 quattro   2.0 
# ... with 224 more rows, and 3 
#   more variables: year <int>, 
#   cyl <int>, trans <chr>

156 1999   6   auto(l4) 
157 1999   6   auto(l4) 
158 2008   6   auto(l4) 
159 2008   8   auto(s4) 
160 1999   4 manual(m5) 
161 1999   4   auto(l4) 
162 2008   4 manual(m5) 
163 2008   4 manual(m5) 
164 2008   4   auto(l4) 
165 2008   4   auto(l4) 
166 1999   4   auto(l4) 
 [ reached getOption("max.print") 
-- omitted 68 rows ]A large table 

to display

as_tibble(x, …) Convert data frame to tibble.  

enframe(x, name = "name", value = "value") 
Convert named vector to a tibble 

is_tibble(x) Test whether x is a tibble.

CONSTRUCT A TIBBLE IN TWO WAYS

Expand Tables - quickly create tables with combinations of values

Tidy Data with tidyr
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Summarise Cases

group_by(.data, ..., add = 
FALSE) 
Returns copy of table  
grouped by …  
g_iris <- group_by(iris, Species) 

ungroup(x, …) 
Returns ungrouped copy  
of table.  
ungroup(g_iris)

wwwwwww

Use group_by() to create a "grouped" copy of a table.  
dplyr functions will manipulate each "group" separately and 
then combine the results.

mtcars %>% 
group_by(cyl) %>% 
summarise(avg = mean(mpg))

These apply summary functions to columns to create a new 
table of summary statistics. Summary functions take vectors as 
input and return one value (see back).

VARIATIONS 
summarise_all() - Apply funs to every column. 
summarise_at() - Apply funs to specific columns.  
summarise_if() - Apply funs to all cols of one type.

www
www

summarise(.data, …) 
Compute table of summaries.  
summarise(mtcars, avg = mean(mpg)) 

count(x, ..., wt = NULL, sort = FALSE) 
Count number of rows in each group defined 
by the variables in … Also tally(). 
count(iris, Species)
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Each observation, or 
case, is in its own row

Each variable is in 
its own column

&

dplyr functions work with pipes and expect tidy data. In tidy data:

pipes

x %>% f(y)  
becomes  f(x, y) filter(.data, …) Extract rows that meet logical 

criteria. filter(iris, Sepal.Length > 7) 

distinct(.data, ..., .keep_all = FALSE) Remove 
rows with duplicate values.  
distinct(iris, Species) 

sample_frac(tbl, size = 1, replace = FALSE,  
weight = NULL, .env = parent.frame()) Randomly 
select fraction of rows.  
sample_frac(iris, 0.5, replace = TRUE) 

sample_n(tbl, size, replace = FALSE, weight = 
NULL, .env = parent.frame()) Randomly select 
size rows. sample_n(iris, 10, replace = TRUE) 

slice(.data, …) Select rows by position.  
slice(iris, 10:15) 

top_n(x, n, wt) Select and order top n entries (by 
group if grouped data). top_n(iris, 5, Sepal.Width)

Row functions return a subset of rows as a new table.

See ?base::logic and ?Comparison for help.
> >= !is.na() ! &
< <= is.na() %in% | xor()

arrange(.data, …) Order rows by values of a 
column or columns (low to high), use with 
desc() to order from high to low. 
arrange(mtcars, mpg) 
arrange(mtcars, desc(mpg))

add_row(.data, ..., .before = NULL, .after = NULL) 
Add one or more rows to a table. 
add_row(faithful, eruptions = 1, waiting = 1)

Group Cases

Manipulate Cases
EXTRACT VARIABLES

ADD CASES

ARRANGE CASES

Logical and boolean operators to use with filter()

Column functions return a set of columns as a new vector or table.

contains(match)  
ends_with(match)  
matches(match)

:, e.g. mpg:cyl 
-, e.g, -Species

num_range(prefix, range) 
one_of(…)  
starts_with(match) 

pull(.data,  var = -1) Extract column values as 
a vector.  Choose by name or index. 
pull(iris, Sepal.Length)

Manipulate Variables

Use these helpers with select (), 
e.g. select(iris, starts_with("Sepal"))

These apply vectorized functions to columns. Vectorized funs take 
vectors as input and return vectors of the same length as output 
(see back).

mutate(.data, …)  
Compute new column(s). 
mutate(mtcars, gpm = 1/mpg) 

transmute(.data, …) 
Compute new column(s), drop others. 
transmute(mtcars, gpm = 1/mpg) 

mutate_all(.tbl, .funs, …) Apply funs to every 
column. Use with funs(). Also mutate_if(). 
mutate_all(faithful, funs(log(.), log2(.))) 
mutate_if(iris, is.numeric, funs(log(.))) 

mutate_at(.tbl, .cols, .funs, …) Apply funs to 
specific columns. Use with funs(), vars() and 
the helper functions for select(). 
mutate_at(iris, vars( -Species), funs(log(.))) 

add_column(.data, ..., .before = NULL, .after = 
NULL) Add new column(s). Also add_count(), 
add_tally(). add_column(mtcars, new = 1:32) 

rename(.data, …) Rename columns. 
rename(iris, Length = Sepal.Length)

MAKE NEW VARIABLES

EXTRACT CASES

wwwwww
wwwwww
wwwwww

wwwwww

wwwwww

wwwwww

wwww

wwwww

wwwwww
www
wwww
w

wwwwww

summary function

vectorized function

Data Transformation with dplyr : : CHEAT SHEET 

A B CA B C

select(.data, …) 
Extract columns as a table. Also select_if(). 
select(iris, Sepal.Length, Species)wwww

dplyr



OFFSETS 
dplyr::lag() - Offset elements by 1 
dplyr::lead() - Offset elements by -1 

CUMULATIVE AGGREGATES 
dplyr::cumall() - Cumulative all() 
dplyr::cumany() - Cumulative any() 

cummax() - Cumulative max() 
dplyr::cummean() - Cumulative mean() 

cummin() - Cumulative min() 
cumprod() - Cumulative prod() 
cumsum() - Cumulative sum() 

RANKINGS 
dplyr::cume_dist() - Proportion of all values <= 
dplyr::dense_rank() - rank with ties = min, no 
gaps 
dplyr::min_rank() - rank with ties = min 
dplyr::ntile() - bins into n bins 
dplyr::percent_rank() - min_rank scaled to [0,1] 
dplyr::row_number() - rank with ties = "first" 

MATH 
+, - , *, /, ^, %/%, %% - arithmetic ops 
log(), log2(), log10() - logs 
<, <=, >, >=, !=, == - logical comparisons 

dplyr::between() - x >= left & x <= right 
dplyr::near() - safe == for floating point 
numbers 

MISC 
dplyr::case_when() - multi-case if_else() 
dplyr::coalesce() - first non-NA values by 
element  across a set of vectors 
dplyr::if_else() - element-wise if() + else() 
dplyr::na_if() - replace specific values with NA 

pmax() - element-wise max() 
pmin() - element-wise min() 

dplyr::recode() - Vectorized switch() 
dplyr::recode_factor() - Vectorized switch() 
for factors 

mutate() and transmute() apply vectorized 
functions to columns to create new columns. 
Vectorized functions take vectors as input and 
return vectors of the same length as output.

Vector Functions
TO USE WITH MUTATE ()

vectorized function

Summary Functions
TO USE WITH SUMMARISE ()

summarise() applies summary functions to 
columns to create a new table. Summary 
functions take vectors as input and return single 
values as output.

COUNTS 
dplyr::n() - number of values/rows 
dplyr::n_distinct() - # of uniques 

sum(!is.na()) - # of non-NA’s 

LOCATION 
mean() - mean, also mean(!is.na()) 
median() - median 

LOGICALS 
mean() - Proportion of TRUE’s 
sum() - # of TRUE’s 

POSITION/ORDER 
dplyr::first() - first value 
dplyr::last() - last value 
dplyr::nth() - value in nth location of vector 

RANK 
quantile() - nth quantile  
min() - minimum value 
max() - maximum value 

SPREAD 
IQR() - Inter-Quartile Range 
mad() - median absolute deviation 
sd() - standard deviation 
var() - variance

Row Names
Tidy data does not use rownames, which store a 
variable outside of the columns. To work with the 
rownames, first move them into a column. 
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rownames_to_column() 
Move row names into col. 
a <- rownames_to_column(iris, var 
= "C") 

column_to_rownames() 
Move col in row names.  
column_to_rownames(a, var = "C") 

summary function

C A B

Also has_rownames(), remove_rownames()

Combine Tables
COMBINE VARIABLES COMBINE CASES

Use bind_cols() to paste tables beside each 
other as they are.  

bind_cols(…) Returns tables placed side by 
side as a single table.  
BE SURE THAT ROWS ALIGN. 

Use a "Mutating Join" to join one table to 
columns from another, matching values with 
the rows that they correspond to.  Each join 
retains a different combination of values from 
the tables. 

left_join(x, y, by = NULL, 
copy=FALSE,  suffix=c(“.x”,“.y”),…) 
Join matching values from y to x. 

right_join(x, y, by = NULL, copy = 
FALSE,  suffix=c(“.x”,“.y”),…) 
Join matching values from x to y. 

inner_join(x, y, by = NULL, copy = 
FALSE,  suffix=c(“.x”,“.y”),…) 
Join data. Retain only rows with 
matches. 

full_join(x, y, by = NULL, 
copy=FALSE,  suffix=c(“.x”,“.y”),…) 
Join data. Retain all values, all rows. 

Use by = c("col1", "col2", …)  to 
specify one or more common 
columns to match on. 
left_join(x, y, by = "A") 

Use a named vector,  by = c("col1" = 
"col2"), to match on columns that 
have different names in each table. 
left_join(x, y, by = c("C" = "D")) 

Use suffix to specify the suffix to 
give to unmatched columns that 
have the same name in both tables. 
left_join(x, y, by = c("C" = "D"), suffix = 
c("1", "2"))

Use bind_rows() to paste tables below each 
other as they are. 

bind_rows(…, .id = NULL) 
Returns tables one on top of the other 
as a single table. Set .id to a column 
name to add a column of the original 
table names (as pictured) 

intersect(x, y, …) 
Rows that appear in both x and y. 

setdiff(x, y, …) 
Rows that appear in x but not y. 

union(x, y, …) 
Rows that appear in x or y.  
(Duplicates removed). union_all() 
retains duplicates.

Use a "Filtering Join" to filter one table against 
the rows of another. 

semi_join(x, y, by = NULL, …) 
Return rows of x that have a match in y. 
USEFUL TO SEE WHAT WILL BE JOINED. 

anti_join(x, y, by = NULL, …) 
Return rows of x that do not have a 
match in y. USEFUL TO SEE WHAT WILL 
NOT BE JOINED.

Use setequal() to test whether two data sets 
contain the exact same rows (in any order). 

EXTRACT ROWS

A B
1 a t
2 b u
3 c v

1 a t
2 b u
3 c v

A B
1 a t
2 b u
3 c v

A B C
1 a t
2 b u
3 c v

x y
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

+ =
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

A B C D
a t 1 3
b u 2 2
c v 3 NA

A B C D
a t 1 3
b u 2 2
d w NA 1

A B C D
a t 1 3
b u 2 2

A B C D
a t 1 3
b u 2 2
c v 3 NA

d w NA 1

A B.x C B.y D
a t 1 t 3
b u 2 u 2
c v 3 NA NA

A.x B.x C A.y B.y
a t 1 d w
b u 2 b u
c v 3 a t

A1 B1 C A2 B2
a t 1 d w
b u 2 b u
c v 3 a t

x

y

A B C
a t 1
b u 2
c v 3

A B C
C v 3
d w 4+

DF A B C
x a t 1
x b u 2
x c v 3
z c v 3
z d w 4

A B C
c v 3

A B C
a t 1
b u 2
c v 3
d w 4

A B C
a t 1
b u 2

x y
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

+ =

A B C
c v 3

A B C
a t 1
b u 2

dplyr



Data Visualization with ggplot2 : : CHEAT SHEET 

ggplot2 is based on the grammar of graphics, the idea 
that you can build every graph from the same 
components: a data set, a coordinate system, 
and geoms—visual marks that represent data points.

Basics
GRAPHICAL PRIMITIVES

a + geom_blank() 
(Useful for expanding limits) 

b + geom_curve(aes(yend = lat + 1, 
xend=long+1,curvature=z)) - x, xend, y, yend, 
alpha, angle, color, curvature, linetype, size 

a + geom_path(lineend="butt", linejoin="round", 
linemitre=1) 
x, y, alpha, color, group, linetype, size 

a + geom_polygon(aes(group = group)) 
x, y, alpha, color, fill, group, linetype, size 

b + geom_rect(aes(xmin = long, ymin=lat, xmax= 
long + 1, ymax = lat + 1)) - xmax, xmin, ymax, 
ymin, alpha, color, fill, linetype, size 

a + geom_ribbon(aes(ymin=unemploy - 900, 
ymax=unemploy + 900)) - x, ymax, ymin, 
alpha, color, fill, group, linetype, size

+ =

To display values, map variables in the data to visual 
properties of the geom (aesthetics) like size, color, and x 
and y locations.

+ =

data geom 
x = F · y = A

coordinate 
system

plot

data geom 
x = F · y = A 
color = F 
size = A

coordinate 
system

plot

Complete the template below to build a graph.
required

ggplot(data = mpg, aes(x = cty, y = hwy)) Begins a plot 
that you finish by adding layers to. Add one geom 
function per layer.      
  

qplot(x = cty, y = hwy, data = mpg, geom = “point") 
Creates a complete plot with given data, geom, and 
mappings. Supplies many useful defaults.     

last_plot() Returns the last plot  

ggsave("plot.png", width = 5, height = 5) Saves last plot 
as 5’ x 5’ file named "plot.png" in working directory. 
Matches file type to file extension.

F M A

F M A

aesthetic mappings data geom

LINE SEGMENTS

b + geom_abline(aes(intercept=0, slope=1)) 
b + geom_hline(aes(yintercept = lat)) 
b + geom_vline(aes(xintercept = long))

common aesthetics: x, y, alpha, color, linetype, size

b + geom_segment(aes(yend=lat+1, xend=long+1)) 
b + geom_spoke(aes(angle = 1:1155, radius = 1))

a <- ggplot(economics, aes(date, unemploy)) 
b <- ggplot(seals, aes(x = long, y = lat))

ONE VARIABLE    continuous
c <- ggplot(mpg, aes(hwy)); c2 <- ggplot(mpg)

c + geom_area(stat = "bin") 
x, y, alpha, color, fill,  linetype, size 

c + geom_density(kernel = "gaussian") 
x, y, alpha, color, fill, group, linetype, size, weight 

c + geom_dotplot()  
x, y, alpha, color, fill 

c + geom_freqpoly() x, y, alpha, color, group, 
linetype, size 

c + geom_histogram(binwidth = 5) x, y, alpha, 
color, fill, linetype, size, weight 

c2 + geom_qq(aes(sample = hwy)) x, y, alpha, 
color, fill, linetype, size, weight

discrete
d <- ggplot(mpg, aes(fl))

d + geom_bar()  
x, alpha, color, fill, linetype, size, weight

e + geom_label(aes(label = cty), nudge_x = 1, 
nudge_y = 1, check_overlap = TRUE) x, y, label, 
alpha, angle, color, family, fontface, hjust, 
lineheight, size, vjust 

e + geom_jitter(height = 2, width = 2)  
x, y, alpha, color, fill, shape, size 

e + geom_point(), x, y, alpha, color, fill, shape, 
size, stroke 

e + geom_quantile(), x, y, alpha, color, group, 
linetype, size, weight 

e + geom_rug(sides = "bl"), x, y, alpha, color, 
linetype, size 

e + geom_smooth(method = lm), x, y, alpha, 
color, fill, group, linetype, size, weight 

e + geom_text(aes(label = cty), nudge_x = 1, 
nudge_y = 1, check_overlap = TRUE), x, y, label, 
alpha, angle, color, family, fontface, hjust, 
lineheight, size, vjust

discrete x , continuous y 
f <- ggplot(mpg, aes(class, hwy))

f + geom_col(), x, y, alpha, color, fill, group, 
linetype, size 

f + geom_boxplot(), x, y, lower, middle, upper, 
ymax, ymin, alpha, color, fill, group, linetype, 
shape, size, weight 

f + geom_dotplot(binaxis = "y", stackdir = 
"center"), x, y, alpha, color, fill, group 

f + geom_violin(scale = "area"), x, y, alpha, color, 
fill, group, linetype, size, weight

discrete x , discrete y 
g <- ggplot(diamonds, aes(cut, color))

g + geom_count(), x, y, alpha, color, fill, shape, 
size, stroke

THREE VARIABLES 
seals$z <- with(seals, sqrt(delta_long^2 + delta_lat^2))l <- ggplot(seals, aes(long, lat))

l + geom_contour(aes(z = z)) 
x, y, z, alpha, colour, group, linetype,  
size, weight

l + geom_raster(aes(fill = z), hjust=0.5, vjust=0.5, 
interpolate=FALSE) 
x, y, alpha, fill 

l + geom_tile(aes(fill = z)), x, y, alpha, color, fill, 
linetype, size, width

h + geom_bin2d(binwidth = c(0.25, 500)) 
x, y, alpha, color, fill, linetype, size, weight 

h + geom_density2d() 
x, y, alpha, colour, group, linetype, size 

h + geom_hex() 
x, y, alpha, colour, fill, size 

 

i + geom_area() 
x, y, alpha, color, fill, linetype, size 

i + geom_line() 
x, y, alpha, color, group, linetype, size 

i + geom_step(direction = "hv") 
x, y, alpha, color, group, linetype, size 
 
 
 

j + geom_crossbar(fatten = 2) 
x, y, ymax, ymin, alpha, color, fill, group, linetype, 
size 

j + geom_errorbar(), x, ymax, ymin, alpha, color, 
group, linetype, size, width (also 
geom_errorbarh()) 

j + geom_linerange() 
x, ymin, ymax, alpha, color, group, linetype, size 

j + geom_pointrange() 
x, y, ymin, ymax, alpha, color, fill, group, linetype, 
shape, size

continuous function 
i <- ggplot(economics, aes(date, unemploy))

visualizing error 
df <- data.frame(grp = c("A", "B"), fit = 4:5, se = 1:2) 
j <- ggplot(df, aes(grp, fit, ymin = fit-se, ymax = fit+se))

maps 
data <- data.frame(murder = USArrests$Murder, 
state = tolower(rownames(USArrests))) 
map <- map_data("state") 
k <- ggplot(data, aes(fill = murder))

k + geom_map(aes(map_id = state), map = map) 
+ expand_limits(x = map$long, y = map$lat), 
map_id, alpha, color, fill, linetype, size

Not  
required, 
sensible 
defaults 
supplied

Geoms Use a geom function to represent data points, use the geom’s aesthetic properties to represent variables.  
Each function returns a layer.

TWO VARIABLES 
continuous x , continuous y 
e <- ggplot(mpg, aes(cty, hwy))

 
continuous bivariate distribution 
h <- ggplot(diamonds, aes(carat, price))
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ggplot (data =  <DATA> ) +  
  <GEOM_FUNCTION> (mapping = aes( <MAPPINGS> ),  
  stat = <STAT> , position = <POSITION> ) +      
  <COORDINATE_FUNCTION> + 
  <FACET_FUNCTION>  + 
  <SCALE_FUNCTION>  + 
  <THEME_FUNCTION>



Scales Coordinate Systems
A stat builds new variables to plot (e.g., count, prop). 

Stats  An alternative way to build a layer

+ =
data geom 

x = x · 
y = ..count..

coordinate 
system

plot

fl cty cyl

x ..count..

stat

Visualize a stat by changing the default stat of a geom 
function, geom_bar(stat="count") or by using a stat 
function, stat_count(geom="bar"), which calls a default 
geom to make a layer (equivalent to a geom function). 
Use ..name.. syntax to map stat variables to aesthetics.

i + stat_density2d(aes(fill = ..level..),  
geom = "polygon")

stat function geommappings

variable created by stat

geom to use

c + stat_bin(binwidth = 1, origin = 10) 
x, y |  ..count.., ..ncount.., ..density.., ..ndensity.. 
c + stat_count(width = 1)  x, y, |  ..count.., ..prop.. 
c + stat_density(adjust = 1, kernel = “gaussian")  
x, y, |  ..count.., ..density.., ..scaled.. 

e + stat_bin_2d(bins = 30, drop = T) 
x, y, fill |  ..count.., ..density.. 
e + stat_bin_hex(bins=30) x, y, fill |  ..count.., ..density.. 
e + stat_density_2d(contour = TRUE, n = 100) 
x, y, color, size |  ..level.. 
e + stat_ellipse(level = 0.95, segments = 51, type = "t") 

l + stat_contour(aes(z = z)) x, y, z, order |  ..level.. 
l + stat_summary_hex(aes(z = z), bins = 30, fun = max) 
x, y, z, fill |  ..value.. 
l + stat_summary_2d(aes(z = z), bins = 30, fun = mean) 
x, y, z, fill |  ..value.. 

f + stat_boxplot(coef = 1.5) x, y |  ..lower..,  
..middle.., ..upper.., ..width.. , ..ymin.., ..ymax.. 
f + stat_ydensity(kernel = "gaussian", scale = “area") x, y |  
..density.., ..scaled.., ..count.., ..n.., ..violinwidth.., ..width.. 

e + stat_ecdf(n = 40)  x, y |  ..x.., ..y.. 
e + stat_quantile(quantiles = c(0.1, 0.9), formula = y ~ 
log(x), method = "rq")  x, y | ..quantile.. 
e + stat_smooth(method = "lm", formula = y ~ x, se=T, 
level=0.95) x, y | ..se.., ..x.., ..y.., ..ymin.., ..ymax.. 

ggplot() + stat_function(aes(x = -3:3), n = 99,  fun = 
dnorm, args = list(sd=0.5)) x |  ..x.., ..y.. 
e + stat_identity(na.rm = TRUE) 
ggplot() + stat_qq(aes(sample=1:100), dist = qt, 
dparam=list(df=5)) sample, x, y |  ..sample.., ..theoretical.. 
e + stat_sum() x, y, size |  ..n.., ..prop.. 
e + stat_summary(fun.data = "mean_cl_boot") 
h + stat_summary_bin(fun.y = "mean", geom = "bar") 
e + stat_unique()

Scales map data values to the visual values of an 
aesthetic. To change a mapping, add a new scale.

(n <- d + geom_bar(aes(fill = fl)))

n + scale_fill_manual( 
values = c("skyblue", "royalblue", "blue", “navy"), 
limits = c("d", "e", "p", "r"), breaks =c("d", "e", "p", “r"), 
name = "fuel", labels = c("D", "E", "P", "R"))

scale_
aesthetic 
to adjust

prepackaged 
scale to use

scale-specific 
arguments

title to use in 
legend/axis

labels to use 
in legend/axis

breaks to use in 
legend/axis

range of 
values to include 

in mapping

GENERAL PURPOSE SCALES 
Use with most aesthetics 
scale_*_continuous() - map cont’ values to visual ones 
scale_*_discrete() - map discrete values to visual ones 
scale_*_identity() - use data values as visual ones 
scale_*_manual(values = c()) - map discrete values to 
manually chosen visual ones 
scale_*_date(date_labels = "%m/%d"), date_breaks = "2 
weeks") - treat data values as dates.  
scale_*_datetime() -  treat data x values as date times. 
Use same arguments as scale_x_date(). See ?strptime for 
label formats.

X & Y LOCATION SCALES 
Use with x or y aesthetics (x shown here) 
scale_x_log10() - Plot x on log10 scale 
scale_x_reverse() - Reverse direction of x axis 
scale_x_sqrt() - Plot x on square root scale

COLOR AND FILL SCALES (DISCRETE) 
n <- d + geom_bar(aes(fill = fl)) 
n + scale_fill_brewer(palette = "Blues")  
For palette choices: 
RColorBrewer::display.brewer.all() 
n + scale_fill_grey(start = 0.2, end = 0.8,  
na.value = "red") 

COLOR AND FILL SCALES (CONTINUOUS) 
o <- c + geom_dotplot(aes(fill = ..x..)) 

o + scale_fill_distiller(palette = "Blues") 
 
o + scale_fill_gradient(low="red", high="yellow") 
 
o + scale_fill_gradient2(low="red", high=“blue", 
mid = "white", midpoint = 25)  
 
o + scale_fill_gradientn(colours=topo.colors(6))  
Also: rainbow(), heat.colors(), terrain.colors(), 
cm.colors(), RColorBrewer::brewer.pal()

SHAPE AND SIZE SCALES 
p <- e + geom_point(aes(shape = fl, size = cyl)) 
p + scale_shape() + scale_size() 
p + scale_shape_manual(values = c(3:7)) 

p + scale_radius(range = c(1,6)) 
p + scale_size_area(max_size = 6)

r <- d + geom_bar() 
r + coord_cartesian(xlim = c(0, 5))  
xlim, ylim 
The default cartesian coordinate system 
r + coord_fixed(ratio = 1/2)  
ratio, xlim, ylim 
Cartesian coordinates with fixed aspect ratio 
between x and y units 
r + coord_flip()  
xlim, ylim 
Flipped Cartesian coordinates 
r + coord_polar(theta = "x", direction=1 )  
theta, start, direction 
Polar coordinates 
r + coord_trans(ytrans = “sqrt")  
xtrans, ytrans, limx, limy 
Transformed cartesian coordinates. Set xtrans and 
ytrans to the name of a window function. 

π + coord_quickmap() 
π + coord_map(projection = "ortho", 
orientation=c(41, -74, 0))projection, orienztation, 
xlim, ylim 
Map projections from the mapproj package 
(mercator (default), azequalarea, lagrange, etc.)

Position Adjustments
Position adjustments determine how to arrange geoms 
that would otherwise occupy the same space. 

s <- ggplot(mpg, aes(fl, fill = drv)) 
s + geom_bar(position = "dodge") 
Arrange elements side by side 
s + geom_bar(position = "fill") 
Stack elements on top of one another,  
normalize height 
e + geom_point(position = "jitter") 
Add random noise to X and Y position of each 
element to avoid overplotting 
e + geom_label(position = "nudge") 
Nudge labels away from points 

s + geom_bar(position = "stack") 
Stack elements on top of one another 

Each position adjustment can be recast as a function with 
manual width and height arguments 
s + geom_bar(position = position_dodge(width = 1))

A
B

Themes
r + theme_bw() 
White background 
with grid lines 
r + theme_gray() 
Grey background  
(default theme) 
r + theme_dark() 
dark for contrast 

r + theme_classic() 
r + theme_light() 
r + theme_linedraw() 
r + theme_minimal() 
Minimal themes 
r + theme_void() 
Empty theme

Faceting
Facets divide a plot into  
subplots based on the  
values of one or more  
discrete variables. 

t <- ggplot(mpg, aes(cty, hwy)) + geom_point() 

t + facet_grid(. ~ fl) 
facet into columns based on fl 
t + facet_grid(year ~ .) 
facet into rows based on year 
t + facet_grid(year ~ fl) 
facet into both rows and columns 
t + facet_wrap(~ fl) 
wrap facets into a rectangular layout 

Set scales to let axis limits vary across facets 

t + facet_grid(drv ~ fl, scales = "free") 
x and y axis limits adjust to individual facets 
"free_x" - x axis limits adjust 
"free_y" - y axis limits adjust 

Set labeller to adjust facet labels 

t + facet_grid(. ~ fl, labeller = label_both) 

t + facet_grid(fl ~ ., labeller = label_bquote(alpha ^ .(fl))) 

t + facet_grid(. ~ fl, labeller = label_parsed)

fl: c fl: d fl: e fl: p fl: r

c d e p r

↵c
↵d ↵e ↵p ↵r

Labels
t + labs(    x = "New x axis label",  y = "New y axis label", 
title ="Add a title above the plot",  
subtitle = "Add a subtitle below title", 
caption = "Add a caption below plot", 
   <aes>  = "New   <aes>    legend title")  
t + annotate(geom = "text", x = 8, y = 9, label = "A")

Use scale functions 
 to update legend 
labels

<AES>

geom to place manual values for geom’s aesthetics

<AES>

Legends
n + theme(legend.position = "bottom") 
Place legend at "bottom", "top", "left", or "right" 
n + guides(fill = "none") 
Set legend type for each aesthetic: colorbar, legend, or 
none (no legend)  
n + scale_fill_discrete(name = "Title",  
labels = c("A", "B", "C", "D", "E")) 
Set legend title and labels with a scale function.

Zooming
Without clipping (preferred) 
t + coord_cartesian( 
xlim = c(0, 100), ylim = c(10, 20)) 
With clipping (removes unseen data points) 
t + xlim(0, 100) + ylim(10, 20) 
t + scale_x_continuous(limits = c(0, 100)) + 
scale_y_continuous(limits = c(0, 100))
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JOIN (TO) LISTS
append(x, values, after = 
length(x)) Add to end of list. 
append(x, list(d = 1)) 

prepend(x, values, before = 
1) Add to start of list. 
prepend(x, list(d = 1)) 

splice(…) Combine objects 
into a list, storing S3 objects 
as sub-lists. splice(x, y, "foo")

+

+

+
+

WORK WITH LISTS
array_tree(array, margin = 
NULL) Turn array into list. 
Also array_branch. 
array_tree(x, margin = 3) 

cross2(.x, .y, .filter = NULL) 
All combinations of .x 
and .y. Also cross, cross3, 
cross_df. cross2(1:3, 4:6) 

set_names(x, nm = x) Set 
the names of a vector/list 
directly or with a function. 
set_names(x, c("p", "q", "r")) 
set_names(x, tolower)

p
q
r

a
b
c

+

a
b
c
d

a
b
c
d

a
b
c
d

a
b
c
d

a
b
c
d

a
b
c
d

TRANSFORM LISTS
modify(.x, .f, ...) Apply 
function to each element. Also 
map, map_chr, map_dbl, 
map_dfc, map_dfr, map_int, 
map_lgl. modify(x, ~.+ 2) 

modify_at(.x, .at, .f, ...) Apply 
function to elements by name 
or index. Also map_at. 
modify_at(x, "b", ~.+ 2) 

modify_if(.x, .p, .f, ...) Apply 
function to elements that  
pass a test. Also map_if. 
modify_if(x, is.numeric,~.+2) 

modify_depth(.x,.depth,.f,...) 
Apply function to each 
element at a given level of a 
list. modify_depth(x, 1, ~.+ 2)

Map functions apply a function iteratively to each element of a list 
or vector.
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Reduce Lists

Work with Lists

Apply functions with purrr : : CHEAT SHEET 

Modify function behavior

a
b
c
d

b

a
b
c

a
c

a
b

a
b
c
d

FILTER LISTS
pluck(.x, ..., .default=NULL) 
Select an element by name 
or index, pluck(x,"b") ,or its 
attribute with attr_getter. 
pluck(x,"b",attr_getter("n")) 

keep(.x, .p, …) Select 
elements that pass a 
logical test. keep(x, is.na) 

discard(.x, .p, …) Select 
elements that do not pass a 
logical test. discard(x, is.na) 

compact(.x, .p = identity) 
Drop empty elements.  
compact(x) 

head_while(.x, .p, …) 
Return head elements  
until one does not pass. 
Also tail_while. 
head_while(x, is.character)

NULLa
b

NULLc

b

RESHAPE LISTS

flatten(.x) Remove a level 
of indexes from a list. Also 
flatten_chr, flatten_dbl, 
flatten_dfc, flatten_dfr, 
flatten_int, flatten_lgl. 
flatten(x) 

transpose(.l, .names = 
NULL) Transposes the index 
order in a multi-level list. 
transpose(x)

a
b
c

x y
a
b
c

x y

a
b
c

a
b
c

x y z 2

a
b
c

FALSE

a
b
c

TRUE

a
b
c

TRUE

SUMMARISE LISTS

a
b
c

c

a
b
c

3

every(.x, .p, …) Do all 
elements pass a test?  
every(x, is.character) 

some(.x, .p, …) Do some 
elements pass a test?  
some(x,  is.character) 

has_element(.x, .y) Does a 
list contain an element? 
has_element(x, "foo") 

detect(.x, .f, ..., .right=FALSE, 
.p) Find first element to pass. 
detect(x,  is.character) 

detect_index(.x, .f, ..., .right 
= FALSE, .p) Find index of 
first element to pass. 
detect_index(x, is.character) 

vec_depth(x) Return depth 
(number of levels of 
indexes). vec_depth(x)

Apply Functions

map(.x, .f, …) Apply a 
function to each 
element of a list or 
vector. map(x, is.logical)

map2(.x, ,y, .f, …) Apply 
a function to pairs of 
elements from two lists, 
vectors. map2(x, y, sum)

pmap(.l, .f, …) Apply a 
function to groups of 
elements from list of lists, 
vectors. pmap(list(x, y, z), 
sum, na.rm = TRUE)

invoke_map(.f, .x = 
list(NULL), …, .env=NULL) 
Run each function in a list. 
Also invoke. l <-  list(var, 
sd); invoke_map(l, x = 1:9)

lmap(.x, .f, ...) Apply function to each list-element of a list or vector. 
imap(.x, .f, ...) Apply .f to each element of a list or vector and its index.

reduce(.x, .f, ..., .init) 
Apply function recursively 
to each element of a list or 
vector. Also reduce_right, 
reduce2, reduce2_right. 
reduce(x, sum)

accumulate(.x, .f, ..., .init) 
Reduce, but also return 
intermediate results. Also 
accumulate_right. 
accumulate(x, sum)

compose() Compose 
multiple functions. 

lift() Change the type 
of input a function 
takes. Also lift_dl, 
lift_dv, lift_ld, lift_lv, 
lift_vd, lift_vl. 

rerun() Rerun 
expression n times.

negate() Negate a 
predicate function (a 
pipe friendly !) 

partial() Create a 
version of a function 
that has some args 
preset to values. 

safely() Modify func 
to return list of  
results and errors.

quietly() Modify 
function to return 
list of results, 
output, messages, 
warnings. 

possibly() Modify  
function to return 
default value 
whenever an error 
occurs (instead of 
error).

a b
func(    ,    )

func(    ,    )
c

func(    ,    )
d

a b c dfunc +

func(    ,    )
func(    ,    )

c

func(    ,    )
d

a b c dfunc +

fun(     ,…) 
fun(     ,…) 
fun(     ,…)

map(      , fun, …)

fun(     ,      ,…) 
fun(     ,      ,…) 
fun(     ,      ,…)

map2(      ,      ,fun,…)

fun(    ,     ,     ,…) 
fun(    ,     ,     ,…) 
fun(    ,     ,     ,…)

pmap(                        ,fun,…)

fun

fun
fun

(     ,…) 
(     ,…) 
(     ,…)

invoke_map(              ,        ,…)
fun

fun
fun

~ .x becomes function(x) x, 
e.g. map(l, ~ 2 +.x) becomes 
map(l, function(x) 2 + x )

"name" becomes  
function(x) x[["name"]], 
e.g. map(l, "a") extracts a 
from each element of l

map(), map2(), pmap(), 
imap and invoke_map 
each return a list. Use a 
suffixed version to 
return the results as a 
specific type of flat 
vector, e.g. map2_chr, 
pmap_lgl, etc. 

Use walk, walk2, and 
pwalk to trigger side 
effects. Each return its 
input invisibly.

OUTPUT

SHORTCUTS - within a purrr function:

~ .x .y becomes  
function(.x, .y) .x .y, e.g.  
map2(l, p, ~ .x +.y ) becomes  
map2(l, p, function(l, p) l + p )

~ ..1 ..2 etc becomes  
function(..1, ..2, etc) ..1 ..2 etc, 
e.g. pmap(list(a, b, c), ~ ..3 + ..1 - ..2) 
becomes pmap(list(a, b, c), 
function(a, b, c) c + a - b)

function returns
map list
map_chr character vector
map_dbl double (numeric) vector
map_dfc data frame (column bind)
map_dfr data frame (row bind)
map_int integer vector
map_lgl logical vector
walk triggers side effects, returns 

the input invisibly

a
b
c

b



purrr::map_lgl(.x, .f, ...) 
Apply .f element-wise to .x, return a logical vector 
n_iris %>% transmute(n = map_lgl(data, is.matrix)) 

purrr::map_int(.x, .f, ...) 
Apply .f element-wise to .x, return an integer vector 
n_iris %>% transmute(n = map_int(data, nrow))
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A nested data frame stores 
individual tables within the 
cells of a larger, organizing 
table. 

Use a nested data frame to: 
• preserve relationships 

between observations and  
subsets of data 

• manipulate many sub-tables  
at once with the purrr functions  map(), map2(), or pmap().

Use a two step process to create a nested data frame: 
1. Group the data frame into groups with dplyr::group_by() 
2. Use nest() to create a nested data frame  

with one row per group

Species S.L S.W P.L P.W
setosa 5.1 3.5 1.4 0.2
setosa 4.9 3.0 1.4 0.2
setosa 4.7 3.2 1.3 0.2
setosa 4.6 3.1 1.5 0.2
setosa 5.0 3.6 1.4 0.2
versi 7.0 3.2 4.7 1.4
versi 6.4 3.2 4.5 1.5
versi 6.9 3.1 4.9 1.5
versi 5.5 2.3 4.0 1.3
versi 6.5 2.8 4.6 1.5

virgini 6.3 3.3 6.0 2.5
virgini 5.8 2.7 5.1 1.9
virgini 7.1 3.0 5.9 2.1
virgini 6.3 2.9 5.6 1.8
virgini 6.5 3.0 5.8 2.2

Species data
setos <tibble [50x4]>
versi <tibble [50x4]>
virgini <tibble [50x4]>

Species S.L S.W P.L P.W
setosa 5.1 3.5 1.4 0.2
setosa 4.9 3.0 1.4 0.2
setosa 4.7 3.2 1.3 0.2
setosa 4.6 3.1 1.5 0.2
setosa 5.0 3.6 1.4 0.2
versi 7.0 3.2 4.7 1.4
versi 6.4 3.2 4.5 1.5
versi 6.9 3.1 4.9 1.5
versi 5.5 2.3 4.0 1.3
versi 6.5 2.8 4.6 1.5
virgini 6.3 3.3 6.0 2.5
virgini 5.8 2.7 5.1 1.9
virgini 7.1 3.0 5.9 2.1
virgini 6.3 2.9 5.6 1.8
virgini 6.5 3.0 5.8 2.2

S.L S.W P.L P.W
5.1 3.5 1.4 0.2
4.9 3.0 1.4 0.2
4.7 3.2 1.3 0.2
4.6 3.1 1.5 0.2
5.0 3.6 1.4 0.2

S.L S.W P.L P.W
7.0 3.2 4.7 1.4
6.4 3.2 4.5 1.5
6.9 3.1 4.9 1.5
5.5 2.3 4.0 1.3
6.5 2.8 4.6 1.5

S.L S.W P.L P.W
6.3 3.3 6.0 2.5
5.8 2.7 5.1 1.9
7.1 3.0 5.9 2.1
6.3 2.9 5.6 1.8
6.5 3.0 5.8 2.2n_iris <- iris %>% group_by(Species) %>% nest()

tidyr::nest(data, ..., .key = data) 
For grouped data, moves groups into cells as data frames.

Unnest a nested data frame 
with unnest():

Species data
setos <tibble [50x4]>
versi <tibble [50x4]>
virgini <tibble [50x4]>

Species S.L S.W P.L P.W
setosa 5.1 3.5 1.4 0.2
setosa 4.9 3.0 1.4 0.2
setosa 4.7 3.2 1.3 0.2
setosa 4.6 3.1 1.5 0.2
versi 7.0 3.2 4.7 1.4
versi 6.4 3.2 4.5 1.5
versi 6.9 3.1 4.9 1.5
versi 5.5 2.3 4.0 1.3

virgini 6.3 3.3 6.0 2.5
virgini 5.8 2.7 5.1 1.9
virgini 7.1 3.0 5.9 2.1
virgini 6.3 2.9 5.6 1.8

n_iris %>% unnest()

tidyr::unnest(data, ..., .drop = NA, .id=NULL, .sep=NULL) 
Unnests a nested data frame.

1 Make a list 
column 3 Simplify 

the list 
column

2 Work with 
list columns

Species S.L S.W P.L P.W
setosa 5.1 3.5 1.4 0.2
setosa 4.9 3.0 1.4 0.2
setosa 4.7 3.2 1.3 0.2
setosa 4.6 3.1 1.5 0.2
versi 7.0 3.2 4.7 1.4
versi 6.4 3.2 4.5 1.5
versi 6.9 3.1 4.9 1.5
versi 5.5 2.3 4.0 1.3
virgini 6.3 3.3 6.0 2.5
virgini 5.8 2.7 5.1 1.9
virgini 7.1 3.0 5.9 2.1
virgini 6.3 2.9 5.6 1.8

Species data
setos <tibble [50x4]>
versi <tibble [50x4]>

virgini <tibble [50x4]>

S.L S.W P.L P.W
5.1 3.5 1.4 0.2
4.9 3.0 1.4 0.2
4.7 3.2 1.3 0.2
4.6 3.1 1.5 0.2

S.L S.W P.L P.W
7.0 3.2 4.7 1.4
6.4 3.2 4.5 1.5
6.9 3.1 4.9 1.5
5.5 2.3 4.0 1.3

S.L S.W P.L P.W
6.3 3.3 6.0 2.5
5.8 2.7 5.1 1.9
7.1 3.0 5.9 2.1
6.3 2.9 5.6 1.8

Species data
setosa <tibble [50 x 4]>

versicolor <tibble [50 x 4]>
virginica <tibble [50 x 4]>

Sepal.L Sepal.W Petal.L Petal.W
5.1 3.5 1.4 0.2
4.9 3.0 1.4 0.2
4.7 3.2 1.3 0.2
4.6 3.1 1.5 0.2
5.0 3.6 1.4 0.2

Sepal.L Sepal.W Petal.L Petal.W
7.0 3.2 4.7 1.4
6.4 3.2 4.5 1.5
6.9 3.1 4.9 1.5
5.5 2.3 4.0 1.3
6.5 2.8 4.6 1.5

Sepal.L Sepal.W Petal.L Petal.W
6.3 3.3 6.0 2.5
5.8 2.7 5.1 1.9
7.1 3.0 5.9 2.1
6.3 2.9 5.6 1.8
6.5 3.0 5.8 2.2

nested data frame

"cell" contents

n_iris

n_iris$data[[1]]

n_iris$data[[2]]

n_iris$data[[3]]

Species data model
setosa <tibble [50x4]> <S3: lm>
versi <tibble [50x4]> <S3: lm>

virgini <tibble [50x4]> <S3: lm>

Call: 
lm(S.L ~ ., df) 
Coefs: 
  (Int)  S.W  P.L  P.W   
    2.3    0.6 0.2   0.2  

Call: 
lm(S.L ~ ., df) 

Coefs: 
  (Int)  S.W  P.L  P.W   
    1.8    0.3 0.9   -0.6  

Call: 
lm(S.L ~ ., df) 
Coefs: 
  (Int)  S.W  P.L  P.W   
    0.6    0.3 0.9   -0.1  

Species beta
setos 2.35
versi 1.89
virgini 0.69

n_iris <- iris %>%  
  group_by(Species) %>%  
  nest()

mod_fun <- function(df)  
    lm(Sepal.Length ~ ., data = df) 

m_iris <- n_iris %>% 
  mutate(model = map(data, mod_fun))

b_fun <- function(mod)  
    coefficients(mod)[[1]] 

m_iris %>% transmute(Species,  
    beta = map_dbl(model, b_fun))

tibble::tibble(…) 
Saves list input as list columns 
tibble(max = c(3, 4, 5), seq = list(1:3, 1:4, 1:5)) 

tibble::enframe(x, name="name", value="value") 
Converts multi-level list to tibble with list cols 
enframe(list('3'=1:3, '4'=1:4, '5'=1:5), 'max', 'seq')

tibble::tribble(…) 
Makes list column when needed 
tribble( ~max, ~seq, 
                          3,    1:3, 
                          4,    1:4, 
                          5,    1:5)

max seq
3 <int [3]>
4 <int [4]>
5 <int [5]>

dplyr::mutate(.data, …) Also transmute() 
Returns list col when result returns list. 
mtcars %>% mutate(seq = map(cyl, seq)) 

dplyr::summarise(.data, …) 
Returns list col when result is wrapped with list() 
mtcars %>%  group_by(cyl) %>% 
   summarise(q = list(quantile(mpg)))

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

model
<S3: lm>
<S3: lm>
<S3: lm>

pmap(list(                      ,               ,          ), fun, …)
funs

coef
AIC
BIC

fun(                      ,               ,          ,…) 
fun(                      ,               ,          ,…) 
fun(                      ,               ,          ,…)

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

model
<S3: lm>
<S3: lm>
<S3: lm>

funs
coef
AIC
BIC

result
result 1
result 2
result 3

result
result 1
result 2
result 3

map2(                      ,               , fun, …)
data

<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

model
<S3: lm>
<S3: lm>
<S3: lm>

fun(                      ,               ,…) 
fun(                      ,               ,…) 
fun(                      ,               ,…)

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

model
<S3: lm>
<S3: lm>
<S3: lm>

map(                      , fun, …)
data

<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

fun(                      , …) 
fun(                      , …) 
fun(                      , …)

data
<tibble [50x4]>
<tibble [50x4]>
<tibble [50x4]>

result
result 1
result 2
result 3

purrr::map(.x, .f, ...) 
Apply .f element-wise to .x as .f(.x) 
n_iris %>% mutate(n = map(data, dim)) 

purrr::map2(.x, .y, .f, ...) 
Apply .f element-wise to .x and .y as .f(.x, .y) 
m_iris %>% mutate(n = map2(data, model, list)) 

purrr::pmap(.l, .f, ...) 
Apply .f element-wise to vectors saved in .l 
m_iris %>%  
  mutate(n = pmap(list(data, model, data), list))

Use the purrr functions map_lgl(), 
map_int(), map_dbl(), map_chr(), 
as well as tidyr’s unnest() to reduce 
a list column into a regular column.

purrr::map_dbl(.x, .f, ...) 
Apply .f element-wise to .x, return a double vector 
n_iris %>% transmute(n = map_dbl(data, nrow)) 

purrr::map_chr(.x, .f, ...) 
Apply .f element-wise to .x, return a character vector 
n_iris %>% transmute(n = map_chr(data, nrow))

Nested Data List Column Workflow Nested data frames use a list column, a list that is stored as a 
column vector of a data frame. A typical workflow for list columns:

3. SIMPLIFY THE LIST COLUMN (into a regular column)

2. WORK WITH LIST COLUMNS - Use the purrr functions map(), map2(), and pmap() to apply a function that returns a result element-wise  
to the cells of a list column. walk(), walk2(), and pwalk() work the same way, but return a side effect.

1. MAKE A LIST COLUMN - You can create list columns with functions in the tibble and dplyr packages, as well as tidyr’s nest()



Join and Split
str_c(..., sep = "", collapse = NULL) Join 
multiple strings into a single string. 
str_c(letters, LETTERS) 

str_c(..., sep = "", collapse = NULL) Collapse 
a vector of strings into a single string. 
str_c(letters, collapse = "") 

str_dup(string, times) Repeat strings times 
times. str_dup(fruit, times = 2) 

str_split_fixed(string, pattern, n) Split a 
vector of strings into a matrix of substrings 
(splitting at occurrences of a pattern match). 
Also str_split to return a list of substrings.  
str_split_fixed(fruit, " ", n=2) 

str_glue(…, .sep = "", .envir = parent.frame()) 
Create a string from strings and {expressions} 
to evaluate. str_glue("Pi is {pi}") 

str_glue_data(.x, ..., .sep = "", .envir = 
parent.frame(), .na = "NA") Use a data frame, 
list, or environment to create a string from 
strings and {expressions} to evaluate. 
str_glue_data(mtcars, "{rownames(mtcars)} 
has {hp} hp")

{xx} {yy}a string

A STRING

A STRING

a string

Mutate Strings
str_sub() <- value. Replace substrings by 
identifying the substrings with str_sub() and 
assigning into the results.  
str_sub(fruit, 1, 3) <- "str" 

str_replace(string, pattern, replacement) 
Replace the first matched pattern in each 
string. str_replace(fruit, "a", "-") 

str_replace_all(string, pattern, 
replacement) Replace all matched patterns 
in each string. str_replace_all(fruit, "a", "-") 

str_to_lower(string, locale = "en")1 Convert 
strings to lower case. 
str_to_lower(sentences) 

str_to_upper(string, locale = "en")1 Convert 
strings to upper case. 
str_to_upper(sentences) 

str_to_title(string, locale = "en")1 Convert 
strings to title case. str_to_title(sentences)

a string

A String

str_conv(string, encoding) Override the 
encoding of a string. str_conv(fruit,"ISO-8859-1") 

str_view(string, pattern, match = NA) View 
HTML rendering of first regex match in each 
string. str_view(fruit, "[aeiou]") 

str_view_all(string, pattern, match = NA) View 
HTML rendering of all regex matches. 
str_view_all(fruit, "[aeiou]") 

str_wrap(string, width = 80, indent = 0, exdent 
= 0) Wrap strings into nicely formatted 
paragraphs. str_wrap(sentences, 20)
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String manipulation with stringr : : CHEAT SHEET 
Detect Matches

str_detect(string, pattern) Detect the 
presence of a pattern match in a string.  
str_detect(fruit, "a") 

str_which(string, pattern) Find the indexes of 
strings that contain a pattern match. 
str_which(fruit, "a") 

str_count(string, pattern) Count the number 
of matches in a string. 
str_count(fruit, "a") 

str_locate(string, pattern) Locate the 
positions of pattern matches in a string. Also 
str_locate_all. str_locate(fruit, "a")

Manage Lengths
TRUE
TRUE
FALSE

TRUE

1
2
4

0
3
1
2

start end

2 4
4 7

NA NA
3 4

str_length(string) The width of strings (i.e. 
number of code points, which generally equals 
the number of characters). str_length(fruit) 

str_pad(string, width, side = c("left", "right", 
"both"), pad = " ") Pad strings to constant 
width. str_pad(fruit, 17) 

str_trunc(string, width, side = c("right", "left", 
"center"), ellipsis = "...") Truncate the width of 
strings, replacing content with ellipsis. 
str_trunc(fruit, 3) 

str_trim(string, side = c("both", "left", "right")) 
Trim whitespace from the start and/or end of a 
string. str_trim(fruit)

4
6
2
3

Helpers

str_order(x, decreasing = FALSE, na_last = 
TRUE, locale = "en", numeric = FALSE, ...)1 Return 
the vector of indexes that sorts a character 
vector. x[str_order(x)] 

str_sort(x, decreasing = FALSE, na_last = TRUE, 
locale = "en", numeric = FALSE, ...)1 Sort a 
character vector. 
str_sort(x)

4
1
3
2

Order Strings

The stringr package provides a set of internally consistent tools for working with character strings, i.e. sequences of characters surrounded by quotation marks.

NA NA

Subset Strings
str_sub(string, start = 1L, end = -1L) Extract 
substrings from a character vector. 
str_sub(fruit, 1, 3); str_sub(fruit, -2) 

str_subset(string, pattern) Return only the 
strings that contain a pattern match. 
str_subset(fruit, "b") 

str_extract(string, pattern) Return the first 
pattern match found in each string, as a vector. 
Also str_extract_all to return every pattern 
match. str_extract(fruit, "[aeiou]") 

str_match(string, pattern) Return the first 
pattern match found in each string, as a  
matrix with a column for each ( ) group in 
pattern. Also str_match_all.  
str_match(sentences, "(a|the) ([^ ]+)")

NA

1 See bit.ly/ISO639-1 for a complete list of locales.



2 ...1 n
n ... m

regexp matches example 

a? zero or one quant("a?") .a.aa.aaa
a* zero or more quant("a*") .a.aa.aaa
a+ one or more quant("a+") .a.aa.aaa
a{n} exactly n quant("a{2}") .a.aa.aaa
a{n, } n or more quant("a{2,}") .a.aa.aaa
a{n, m} between n and m quant("a{2,4}") .a.aa.aaa

string  
(type this)

regexp  
(to mean this)

matches  
(which matches this)

example 
(the result is the same as ref("abba"))

\\1 \1 (etc.) first () group, etc. ref("(a)(b)\\2\\1") abbaab

regexp matches example 

^a start of string anchor("^a") aaa
a$ end of string anchor("a$") aaa

regexp matches example 

ab|d or alt("ab|d") abcde
[abe] one of alt("[abe]") abcde
[^abe] anything but alt("[^abe]") abcde
[a-c] range alt("[a-c]") abcde

regex(pattern, ignore_case = FALSE, multiline = 
FALSE, comments = FALSE, dotall = FALSE, ...) 
Modifies a regex to ignore cases, match end of 
lines as well of end of strings, allow R comments 
within regex's , and/or to have . match everything 
including \n.  
str_detect("I", regex("i", TRUE))  

fixed() Matches raw bytes but will miss some 
characters that can be represented in multiple 
ways (fast). str_detect("\u0130", fixed("i")) 

coll() Matches raw bytes and will use locale 
specific collation rules to recognize characters 
that can be represented in multiple ways (slow). 
str_detect("\u0130", coll("i", TRUE, locale = "tr")) 

boundary() Matches boundaries between 
characters, line_breaks, sentences, or words. 
str_split(sentences, boundary("word"))

Special Character Represents
\\ \
\" "
\n new line

Need to Know Regular Expressions -
Pattern arguments in stringr are interpreted as 
regular expressions after any special characters 
have been parsed. 

In R, you write regular expressions as strings, 
sequences of characters surrounded by quotes 
("") or single quotes('').  

Some characters cannot be represented directly 
in an R string . These must be represented as 
special characters, sequences of characters that 
have a specific meaning., e.g.
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Run ?"'" to see a complete list

Because of this, whenever a \ appears in a regular 
expression, you must write it as \\ in the string 
that represents the regular expression. 

Use writeLines() to see how R views your string 
after all special characters have been parsed. 

writeLines("\\.")  
# \. 

writeLines("\\ is a backslash")  
# \ is a backslash

MATCH CHARACTERS

quant <- function(rx) str_view_all(".a.aa.aaa", rx)QUANTIFIERS

anchor <- function(rx) str_view_all("aaa", rx)ANCHORS

GROUPS
Use parentheses to set precedent (order of evaluation) and create groups

Use an escaped number to refer to and duplicate parentheses groups that occur 
earlier in a pattern. Refer to each group by its order of appearance

ref <- function(rx) str_view_all("abbaab", rx)

alt <- function(rx) str_view_all("abcde", rx)ALTERNATES

look <- function(rx) str_view_all("bacad", rx)LOOK AROUNDS

INTERPRETATION

Patterns in stringr are interpreted as regexs To 
change this default, wrap the pattern in one of:

regexp  matches  example 
(ab|d)e sets precedence alt("(ab|d)e") abcde

see <- function(rx) str_view_all("abc ABC 123\t.!?\\(){}\n", rx)

Regular expressions, or regexps, are a concise language for 
describing patterns in strings. 

a b c d e f

g h i j k l

m n o p q r

s t u v w x

z

[:lower:]

A B C D E F

G H I J K L

M N O P Q R

S T U V W X

Z

[:upper:]

[:alpha:]

0 1 2 3 4 5 6 7 8 9

[:digit:]

[:alnum:]

[:punct:]

. , : ; ? ! \ | / `  = * + - ^

_ ~ " ' [ ] { } ( ) < > @ # $

[:graph:]

.[:blank:]

[:space:]

space
tab

new line�
 

1 Many base R functions require classes to be wrapped in a second set of [ ], e.g.  [[:digit:]]

string (type 
this)

regexp  
(to mean this)

matches  
(which matches this)

example 

a  (etc.) a (etc.) see("a") abc ABC 123   .!?\(){}
\\. \. . see("\\.") abc ABC 123   .!?\(){}
\\! \! ! see("\\!") abc ABC 123   .!?\(){}
\\? \? ? see("\\?") abc ABC 123   .!?\(){}
\\\\ \\ \ see("\\\\") abc ABC 123   .!?\(){}
\\( \( ( see("\\(") abc ABC 123   .!?\(){}
\\) \) ) see("\\)") abc ABC 123   .!?\(){}
\\{ \{ { see("\\{") abc ABC 123   .!?\(){}
\\} \} } see( "\\}") abc ABC 123   .!?\(){}
\\n \n new line (return) see("\\n") abc ABC 123   .!?\(){}
\\t \t tab see("\\t") abc ABC 123   .!?\(){}
\\s \s any whitespace  (\S for non-whitespaces) see("\\s") abc ABC 123   .!?\(){}
\\d \d any digit  (\D for non-digits) see("\\d") abc ABC 123   .!?\(){}
\\w \w any word character  (\W for non-word chars) see("\\w") abc ABC 123   .!?\(){}
\\b \b word boundaries see("\\b") abc ABC 123   .!?\(){}

[:digit:] digits see("[:digit:]") abc ABC 123   .!?\(){}
[:alpha:] letters see("[:alpha:]") abc ABC 123   .!?\(){}
[:lower:] lowercase letters see("[:lower:]") abc ABC 123   .!?\(){}
[:upper:] uppercase letters see("[:upper:]") abc ABC 123   .!?\(){}
[:alnum:] letters and numbers see("[:alnum:]") abc ABC 123   .!?\(){}
[:punct:] punctuation see("[:punct:]") abc ABC 123   .!?\(){}
[:graph:] letters, numbers, and punctuation see("[:graph:]") abc ABC 123   .!?\(){}
[:space:] space characters (i.e. \s) see("[:space:]") abc ABC 123   .!?\(){}
[:blank:] space and tab (but not new line) see("[:blank:]") abc ABC 123   .!?\(){}
. every character except a new line see(".") abc ABC 123   .!?\(){}

1 
1 
1 
1 
1 

1 
1 
1 
1 

1 2 ... n

regexp matches example 

a(?=c) followed by look("a(?=c)") bacad
a(?!c) not followed by look("a(?!c)") bacad
(?<=b)a preceded by look("(?<=b)a") bacad
(?<!b)a not preceded by look("(?<!b)a") bacad
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2018-01-31 11:59:59

2018-01-31 11:59:59

2018-01-31 11:59:59

2017-11-28 12:00:00

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at lubridate.tidyverse.org •  lubridate  1.6.0  •   Updated: 2017-12

Dates and times with lubridate : : CHEAT SHEET 
Date-times

2017-11-28 12:00:00 
A date-time is a point on the timeline, 
stored as the number of seconds since 
1970-01-01 00:00:00 UTC 

dt <- as_datetime(1511870400) 
## "2017-11-28 12:00:00 UTC"

1. Identify the order of the year (y), month (m), day (d), hour (h), 
minute (m) and second (s) elements in your data. 

2. Use the function below whose name replicates the order. Each 
accepts a wide variety of input formats.

PARSE DATE-TIMES (Convert strings or numbers to date-times)

date_decimal(decimal, tz = "UTC") 
date_decimal(2017.5) 

now(tzone = "") Current time in  tz 
(defaults to system tz). now() 

today(tzone = "") Current date in a 
tz (defaults to system tz). today() 

fast_strptime() Faster strptime. 
fast_strptime('9/1/01', '%y/%m/%d') 

parse_date_time() Easier strptime. 
parse_date_time("9/1/01", "ymd")

ymd_hms(), ymd_hm(), ymd_h(). 
ymd_hms("2017-11-28T14:02:00") 

ydm_hms(), ydm_hm(), ydm_h(). 
ydm_hms("2017-22-12 10:00:00") 

mdy_hms(), mdy_hm(), mdy_h(). 
mdy_hms("11/28/2017 1:02:03") 

dmy_hms(), dmy_hm(), dmy_h(). 
dmy_hms("1 Jan 2017 23:59:59") 

ymd(), ydm(). ymd(20170131) 

mdy(), myd(). mdy("July 4th, 2000") 

dmy(), dym(). dmy("4th of July '99") 

yq() Q for quarter. yq("2001: Q3") 

hms::hms() Also lubridate::hms(), 
hm() and ms(), which return 
periods.* hms::hms(sec = 0, min= 1, 
hours = 2)

2017-11-28T14:02:00

2017-22-12 10:00:00

11/28/2017 1:02:03

1 Jan 2017 23:59:59

20170131

July 4th, 2000
4th of July '99

2001: Q3

2:01

2017.5

2016 2017 2018 2019 2020

J F M A M
J A S O N
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D

x

2017-11-28 
A date is a day stored as 
the number of days since 
1970-01-01 

d <- as_date(17498) 
## "2017-11-28"

12:00:00 
An hms is a time stored as 
the number of seconds since 
00:00:00 

t <- hms::as.hms(85) 
## 00:01:25

GET AND SET COMPONENTS

date(x) Date component. date(dt) 

year(x) Year. year(dt) 
isoyear(x) The ISO 8601 year.  
epiyear(x) Epidemiological year. 

month(x, label, abbr) Month. 
month(dt) 

day(x) Day of month. day(dt) 
wday(x,label,abbr) Day of week. 
qday(x) Day of quarter. 

hour(x) Hour. hour(dt) 

minute(x) Minutes. minute(dt) 

second(x) Seconds. second(dt) 

week(x) Week of the year. week(dt) 
isoweek() ISO 8601 week. 
epiweek() Epidemiological week. 

quarter(x, with_year = FALSE) 
Quarter. quarter(dt) 

semester(x, with_year = FALSE) 
Semester. semester(dt) 

am(x) Is it in the am? am(dt)  
pm(x) Is it in the pm? pm(dt) 

dst(x) Is it daylight savings? dst(d) 

leap_year(x) Is it a leap year? 
leap_year(d) 

update(object, ..., simple = FALSE) 
update(dt, mday = 2, hour = 1)

Use an accessor function to get a component.  
Assign into an accessor function to change a 
component in place. 

d ## "2017-11-28" 
day(d) ## 28 
day(d) <- 1 
d ## "2017-11-01"

January

xxxxxxxx

Time Zones
R recognizes ~600 time zones. Each encodes the time zone, Daylight 
Savings Time, and historical calendar variations for an area. R assigns 
one time zone per vector. 

Use the UTC time zone to avoid Daylight Savings. 

OlsonNames() Returns  a list of valid time zone names. OlsonNames()

with_tz(time, tzone = "") Get 
the same date-time in a new 
time zone (a new clock time). 
with_tz(dt, "US/Pacific") 

force_tz(time, tzone = "") Get 
the same clock time in a new 
time zone (a new date-time).  
force_tz(dt, "US/Pacific")

PT
MT CT ET

7:00 
Eastern

6:00 
Central

5:00 
Mountain4:00 

Pacific

7:00 
Eastern

7:00 
Central

7:00 
Mountain

7:00 
Pacific

stamp() Derive a template from an example string and return a new 
function that will apply the template to date-times. Also 
stamp_date() and stamp_time(). 

1. Derive a template, create a function 
sf <- stamp("Created Sunday, Jan 17, 1999 3:34") 

2. Apply the template to dates 
sf(ymd("2010-04-05")) 
## [1] "Created Monday, Apr 05, 2010 00:00"  

Tip: use a  
date with  
day > 12

Stamp Date-times

Round Date-times
floor_date(x, unit = "second") 
Round down to nearest unit. 
floor_date(dt, unit = "month") 

round_date(x, unit = "second") 
Round to nearest unit. 
round_date(dt, unit = "month") 

ceiling_date(x, unit = "second", 
change_on_boundary = NULL) 
Round up to nearest unit. 
ceiling_date(dt, unit = "month") 

rollback(dates, roll_to_first = 
FALSE, preserve_hms = TRUE) 
Roll back to last day of previous 
month. rollback(dt)

Jan Feb Mar Apr

Jan Feb Mar Apr

Jan Feb Mar Apr



Make an interval with interval() or %--%, e.g. 

i <- interval(ymd("2017-01-01"), d)         ## 2017-01-01 UTC--2017-11-28 UTC 
j <- d %--% ymd("2017-12-31")                  ## 2017-11-28 UTC--2017-12-31 UTC

PERIODS DURATIONS
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years(x = 1) x years. 
months(x) x months. 
weeks(x = 1) x weeks. 
days(x = 1) x days. 
hours(x = 1) x hours. 
minutes(x = 1) x minutes. 
seconds(x = 1) x seconds. 
milliseconds(x = 1) x milliseconds. 
microseconds(x = 1) x microseconds 
nanoseconds(x = 1) x nanoseconds. 
picoseconds(x = 1) x picoseconds. 

period(num = NULL, units = "second", ...) 
An automation friendly period constructor. 
period(5, unit = "years")  

as.period(x, unit) Coerce a timespan to a 
period, optionally in the specified units. 
Also is.period(). as.period(i) 

period_to_seconds(x) Convert a period to 
the "standard" number of seconds implied 
by the period. Also seconds_to_period(). 
period_to_seconds(p)

Add or subtract periods to model events that happen at specific clock 
times, like the NYSE opening bell.

dyears(x = 1) 31536000x seconds. 
dweeks(x = 1) 604800x seconds. 
ddays(x = 1) 86400x seconds. 
dhours(x = 1) 3600x seconds. 
dminutes(x = 1) 60x seconds. 
dseconds(x = 1) x  seconds. 
dmilliseconds(x = 1) x x 10-3 seconds. 
dmicroseconds(x = 1) x x 10-6 seconds. 
dnanoseconds(x = 1) x x 10-9 seconds. 
dpicoseconds(x = 1) x x 10-12 seconds. 

duration(num = NULL, units = "second", ...) 
An automation friendly duration 
constructor. duration(5, unit = "years") 

as.duration(x, …) Coerce a timespan to a 
duration. Also is.duration(), is.difftime(). 
as.duration(i) 

make_difftime(x) Make difftime with the 
specified number of units. 
make_difftime(99999)

Make a period with the name of a time unit pluralized, e.g. 

p <- months(3) + days(12) 
p 
"3m 12d 0H 0M 0S"

Make a duration with the name of a period prefixed with a d, e.g. 

dd <- ddays(14) 
dd 
"1209600s (~2 weeks)"

Add or subtract durations to model physical processes, like battery life. 
Durations are stored as seconds, the only time unit with a consistent length. 
Difftimes are a class of durations found in base R.

Number 
of days etc.Number 

of months
Exact 

length in 
seconds

Equivalent  
in common 

units

INTERVALS
Divide an interval by a duration to determine its physical length, divide 
an interval by a period to determine its implied length in clock time.

Math with  Date-times —   Lubridate provides three classes of timespans to facilitate math with dates and date-times 

a %within% b  Does interval or date-time a fall 
within interval b? now() %within% i 

int_start(int) Access/set the start date-time of 
an interval. Also int_end(). int_start(i) <- now(); 
int_start(i) 

int_aligns(int1, int2) Do two intervals share a 
boundary? Also int_overlaps(). int_aligns(i, j) 

int_diff(times) Make the intervals that occur 
between the date-times in a vector.  
v <-c(dt, dt + 100, dt + 1000); int_diff(v) 

int_flip(int) Reverse the direction of an 
interval. Also int_standardize(). int_flip(i) 

int_length(int) Length in seconds. int_length(i) 

int_shift(int, by) Shifts an interval up or down 
the timeline by a timespan. int_shift(i, days(-1)) 

as.interval(x, start, …) Coerce a timespans to 
an interval with the start date-time. Also 
is.interval(). as.interval(days(1), start = now())

 l 

Start 
Date

End 
Date

Math with date-times relies on the timeline, 
which behaves inconsistently.  Consider how 
the timeline behaves during: 

A normal day 
nor <- ymd_hms("2018-01-01 01:30:00",tz="US/Eastern") 

The start of daylight savings (spring forward) 
gap <- ymd_hms("2018-03-11 01:30:00",tz="US/Eastern") 

The end of daylight savings (fall back) 
lap <- ymd_hms("2018-11-04 00:30:00",tz="US/Eastern") 

Leap years and leap seconds 
leap <- ymd("2019-03-01")

12:00 1:00 2:00 3:00

2019 2020 2021

1:00 2:00 3:00 4:00

1:00 2:00 3:00 4:00

Durations track the passage of 
physical time, which deviates from 
clock time when irregularities occur. 

nor + dminutes(90) 

gap + dminutes(90) 

lap + dminutes(90) 

leap + dyears(1)

12:00 1:00 2:00 3:00

2019 2020 2021

1:00 2:00 3:00 4:00

1:00 2:00 3:00 4:00

Periods track changes in clock times, 
which ignore time line irregularities.  

nor + minutes(90) 

gap + minutes(90) 

lap + minutes(90) 

leap + years(1)

12:00 1:00 2:00 3:00

1:00 2:00 3:00 4:00

1:00 2:00 3:00 4:00

2019 2020 2021

Intervals represent specific intervals 
of the timeline, bounded by start and 
end date-times.  

interval(nor, nor + minutes(90)) 

interval(gap, gap + minutes(90)) 

interval(lap, lap + minutes(90)) 

interval(leap, leap + years(1))

12:00 1:00 2:00 3:00

1:00 2:00 3:00 4:00

1:00 2:00 3:00 4:00

2019 2020 2021

Not all years  
are 365 days  
due to leap days. 
Not all minutes  
are 60 seconds due to  
leap seconds. 
It is possible to create an imaginary date 
by adding months, e.g. February 31st 
jan31 <- ymd(20180131) 
jan31 + months(1) 
## NA 
%m+% and %m-% will roll imaginary 
dates to the last day of the previous 
month. 
jan31 %m+% months(1) 
## "2018-02-28" 
add_with_rollback(e1, e2, roll_to_first = 
TRUE) will roll imaginary dates to the 
first day of the new month. 
add_with_rollback(jan31, months(1), 
roll_to_first = TRUE) 
## "2018-03-01"



Package: mypackage 
Title: Title of Package 
Version: 0.1.0 
Authors@R: person("Hadley", "Wickham", email =  
    "hadley@me.com", role = c("aut", "cre")) 
Description: What the package does (one paragraph) 
Depends: R (>= 3.1.0) 
License: GPL-2 
LazyData: true 
Imports:  
    dplyr (>= 0.4.0), 
    ggvis (>= 0.2) 
Suggests: 
    knitr (>= 0.1.0)

Suggest packages that are not very 
essential to yours. Users can install 
them manually, or not, as they like.

�

Use � tests/ to store tests that will alert you if your code breaks.

Add a tests/ directory  

Import testthat with devtools::use_testthat(), which 
sets up package to use automated tests with testthat 

Write tests with context(), test(), and expect statements 

Save your tests as .R files in tests/testthat/

1. Modify your code or tests. 
2. Test your code with one of  

devtools::test() 
Runs all tests in � tests/  

Ctrl/Cmd + Shift + T  
(keyboard shortcut) 

3. Repeat until all tests pass

�
�

context("Arithmetic") 

test_that("Math works", { 
  expect_equal(1 + 1, 2) 
  expect_equal(1 + 2, 3) 
  expect_equal(1 + 3, 4) 
})

Package Structure

Package Development: : CHEAT SHEET 
Setup (� DESCRIPTION)

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at http://r-pkgs.had.co.nz/  •  devtools 1.5.1  •  Updated: 2015-01

The contents of a package can be stored on disk as a: 
• source - a directory with sub-directories (as above) 
• bundle - a single compressed file (.tar.gz) 
• binary - a single compressed file optimized for a specific OS 

Or installed into an R library (loaded into memory during an R 
session) or archived online in a repository. Use the functions 
below to move between these states.

install.packages() CRAN ○
install.packages(type = "source") CRAN ○

○ ○
R CMD install ○ ○

○ ○
devtools::install() ○
devtools::build() ○ ○
devtools::install_github() github ○
devtools::load_all() ○ ○
Build & Reload (RStudio) ○ ○ ○
library() ○ ○

Internet On disk library memory
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A package is a convention for organizing files into directories.  

This sheet shows how to work with the 7 most common parts of 
an R package:

� Package 
�  DESCRIPTION 
�  R/ 
�  tests/ 
�  man/ 
�  vignettes/ 
�  data/ 
�  NAMESPACE 

devtools::use_build_ignore("file") 
Adds file to .Rbuildignore, a list of files that will not be included 
when package is built.

SETUP
WRITE CODE

TEST
DOCUMENT

TEACH
ADD DATA
ORGANIZE

You must have a DESCRIPTION file 

Add the packages that yours relies on with 
devtools::use_package() 

Adds a package to the Imports or Suggests field

�
�

MIT license applies to 
your code if re-shared.

MIT

Visit r-pkgs.had.co.nz to 
learn much more about 
writing and publishing 
packages for R

All of the R code in your package goes in � R/. A package with just 
an R/ directory is still a very useful package.

Create a new package project with 

devtools::create("path/to/name") 
Create a template to develop into a package. 

Save your code in � R/ as scripts (extension .R)

1. Edit your code. 
2. Load your code with one of  

devtools::load_all() 
Re-loads all saved files in � R/ into memory.  

Ctrl/Cmd + Shift + L (keyboard shortcut) 
Saves all open files then calls load_all(). 

3. Experiment in the console. 
4. Repeat.

�

�

• Use consistent style with r-pkgs.had.co.nz/r.html#style 
• Click on a function and press F2 to open its definition 
• Search for a function with Ctrl + .

Import packages that your package 
must have to work. R will install them 
when it installs your package.

GPL-2 license applies to your 
code, and all code anyone 
bundles with it, if re-shared.

GPL-2
No strings attached.

CC0

WORKFLOW

Write Code ( � R/)

Expect statement Tests

expect_equal() is equal within small numerical tolerance?
expect_identical() is exactly equal?
expect_match() matches specified string or regular 

expression?expect_output() prints specified output?
expect_message() displays specified message?
expect_warning() displays specified warning?
expect_error() throws specified error?
expect_is() output inherits from certain class?
expect_false() returns FALSE?
expect_true() returns TRUE?

Example Test

WORKFLOW

�

Test ( � tests/)

The  � DESCRIPTION file describes your work,  sets up how your 
package will work with other packages, and applies a copyright.



.Rd FORMATTING TAGS

Add Data (� data/)
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Document (� man/)

Organize (� NAMESPACE)

Teach (� vignettes/)

--- 
title: "Vignette Title" 
author: "Vignette Author" 
date: "`r Sys.Date()`" 
output: rmarkdown::html_vignette 
vignette: > 
  %\VignetteIndexEntry{Vignette Title} 
  %\VignetteEngine{knitr::rmarkdown} 
  \usepackage[utf8]{inputenc} 
---

� vignettes/ holds documents that teach your users how to solve real problems with your tools.

Create a � vignettes/  directory and a template vignette with 

devtools::use_vignette() 
Adds template vignette as vignettes/my-vignette.Rmd. 

Append YAML headers to your vignettes (like right) 
Write the body of your vignettes in R Markdown 
(rmarkdown.rstudio.com)

�

�
�

\email{name@@foo.com} 
\href{url}{display} 
\url{url} 

\link[=dest]{display} 
\linkS4class{class} 
\code{\link{function}} 
\code{\link[package]{function}} 

\tabular{lcr}{ 
    left \tab centered \tab right \cr 
    cell \tab cell            \tab cell   \cr 
}

\emph{italic text} 
\strong{bold text} 
\code{function(args)} 
\pkg{package} 

\dontrun{code} 
\dontshow{code} 
\donttest{code} 

\deqn{a + b (block)} 
\eqn{a + b (inline)}

� man/ contains the documentation for your functions, the help  
pages in your package.

1. Add roxygen comments in your .R files 
2. Convert roxygen comments into documentation with one of: 

devtools::document() 
Converts roxygen comments to .Rd files and places 
them in � man/. Builds NAMESPACE. 

Ctrl/Cmd + Shift + D (Keyboard Shortcut) 

3. Open help pages with ? to preview documentation 
4. Repeat

Use roxygen comments to document each function 
beside its definition 

Document the name of each exported data set 

Include helpful examples for each function

�
�
�

WORKFLOW

The roxygen2 package lets you write  
documentation inline in your .R files with a  
shorthand syntax. devtools implements  
roxygen2 to make documentation. 

• Add roxygen documentation as comment lines  
that begin with #’.  

• Place comment lines directly above the code that defines the 
object documented.  

• Place a roxygen @ tag (right) after #’ to supply a specific 
section of documentation.  

• Untagged lines will be used to generate a title, description, 
and details section (in that order)

#' Add together two numbers. 
#'  
#' @param x A number. 
#' @param y A number. 
#' @return The sum of \code{x} and \code{y}. 
#' @examples 
#' add(1, 1) 
#' @export 
add <- function(x, y) { 
  x + y 
}

data

S4

RC

@aliases 
@concepts 
@describeIn 
@examples 
@export 
@family

@inheritParams 
@keywords 
@param 
@rdname 
@return 
@section

@seealso 
@format 
@source 
@include 
@slot 
@field

COMMON ROXYGEN TAGS

devtools::use_data() 
Adds a data object to data/  
(R/Sysdata.rda if internal = TRUE) 

devtools::use_data_raw() 
Adds an R Script used to clean a data set to data-raw/. 
Includes data-raw/ on .Rbuildignore. 

Save data as .Rdata files (suggested)  

Store data in one of data/, R/Sysdata.rda, inst/extdata 

Always use LazyData: true in your DESCRIPTION file.

�
�
�

Store data in  
• data/ to make data available to package users 
• R/sysdata.rda to keep data internal for use by your 

functions. 
• inst/extdata to make raw data available for loading and 

parsing examples. Access this data with system.file()

The � data/ directory allows you to  
include data with your package.

The  � NAMESPACE file helps you make your package self-
contained: it won’t interfere with other packages, and other 
packages won’t interfere with it.

Export functions for users by placing @export in their 
roxygen comments 

Import objects from other packages with 
package::object (recommended) or  @import, 
@importFrom, @importClassesFrom, 
@importMethodsFrom (not always recommended)

1. Modify your code or tests. 
2. Document your package (devtools::document()) 
3. Check NAMESPACE 
4. Repeat until NAMESPACE is correct

�

�

WORKFLOW

SUBMIT YOUR PACKAGE 
r-pkgs.had.co.nz/release.html

ROXYGEN2



Intro

Deep Learning with Keras : : CHEAT SHEET 
Keras is a high-level neural networks API 
developed with a focus on enabling fast 
experimentation. It supports multiple back-
ends, including TensorFlow, CNTK and Theano. 

TensorFlow is a lower level mathematical 
library for building deep neural network 
architectures. The keras R package makes it 
easy to use Keras and TensorFlow in R.

Working with keras models
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• Optimiser 
• Loss 
• Metrics

• Model 
• Sequential 

model 
• Multi-GPU 

model

Define Compile
• Batch size 
• Epochs 
• Validation 

split 

Fit

• Evaluate 
• Plot 

Evaluate

• classes 
• probability 

Predict The keras R package uses the Python keras library.  
You can install all the prerequisites directly from R.

library(keras) 
install_keras()

This installs the required libraries in an Anaconda 
environment or virtual environment 'r-tensorflow'. 

INSTALLATION

# input layer: use MNIST images 
mnist <- dataset_mnist() 
x_train <- mnist$train$x;  y_train <- mnist$train$y 
x_test <- mnist$test$x;  y_test <- mnist$test$y 

# reshape and rescale 
x_train <- array_reshape(x_train, c(nrow(x_train), 784)) 
x_test <- array_reshape(x_test, c(nrow(x_test), 784)) 
x_train <- x_train / 255;  x_test <- x_test / 255 

y_train <- to_categorical(y_train, 10) 
y_test <- to_categorical(y_test, 10) 

# defining the model and layers 
model <- keras_model_sequential()  
model %>%  
  layer_dense(units = 256, activation = 'relu', 
                         input_shape = c(784)) %>%  
  layer_dropout(rate = 0.4) %>%  
  layer_dense(units = 128, activation = 'relu') %>% 
  layer_dense(units = 10, activation = 'softmax’) 

# compile (define loss and optimizer) 
model %>% compile( 
  loss = 'categorical_crossentropy', 
  optimizer = optimizer_rmsprop(), 
  metrics = c('accuracy’) 
) 

# train (fit) 
model %>% fit( 
  x_train, y_train,  
  epochs = 30, batch_size = 128,  
  validation_split = 0.2 
) 
model %>% evaluate(x_test, y_test) 
model %>% predict_classes(x_test)

DEFINE A MODEL

keras_model() Keras Model 

keras_model_sequential() Keras Model composed of 
a linear stack of layers 

multi_gpu_model() Replicates a model on different 
GPUs

compile(object, optimizer, loss, metrics = NULL) 
Configure a Keras model for training

COMPILE A MODEL

fit(object, x = NULL, y = NULL, batch_size = NULL, 
epochs = 10,   verbose = 1, callbacks = NULL, …) 
Train a Keras model for a fixed number of epochs 
(iterations) 

fit_generator() Fits the model on data yielded batch-
by-batch by a generator 

train_on_batch() test_on_batch() Single gradient 
update or model evaluation over one batch of 
samples 

FIT A MODEL

evaluate(object, x = NULL, y = NULL, batch_size = 
NULL) Evaluate a Keras model 

evaluate_generator() Evaluates the model on a data 
generator

EVALUATE A MODEL

OTHER MODEL OPERATIONS

summary() Print a summary of a Keras model 

export_savedmodel() Export a saved model 

get_layer() Retrieves a layer based on either its 
name (unique) or index 

pop_layer() Remove the last layer in a model 

save_model_hdf5(); load_model_hdf5() Save/
Load models using HDF5 files 

serialize_model(); unserialize_model() 
Serialize a model to an R object 

clone_model() Clone a model instance 

freeze_weights(); unfreeze_weights() 
Freeze and unfreeze weights

PREDICT

predict() Generate predictions from a Keras model 

predict_proba() and predict_classes() 
Generates probability or class probability predictions 
for the input samples 

predict_on_batch() Returns predictions for a single 
batch of samples 

predict_generator() Generates predictions for the 
input samples from a data generator

layer_input() Input layer 

layer_dense() Add a densely-
connected NN layer to an output 

layer_activation() Apply an 
activation function to an output 

layer_dropout() Applies Dropout 
to the input 

layer_reshape() Reshapes an 
output to a certain shape 

layer_permute() Permute the 
dimensions of an input according 
to a given pattern 

layer_repeat_vector() Repeats 
the input n times 

layer_lambda(object, f) Wraps 
arbitrary expression as a layer 

layer_activity_regularization() 
Layer that applies an update to 
the cost function based input 
activity 

layer_masking() Masks a 
sequence by using a mask value to 
skip timesteps 

layer_flatten() Flattens an input

n

x f(x)

L2L1

https://keras.rstudio.com/reference/install_keras.html

CORE LAYERS

See ?install_keras 
for GPU instructions

TRAINING AN IMAGE RECOGNIZER ON MNIST DATA

https://keras.rstudio.com 

https://www.manning.com/books/deep-learning-with-r 
The “Hello, World!” 

of deep learning

Keras TensorFlow



More layers
CONVOLUTIONAL LAYERS

POOLING LAYERS

layer_conv_1d() 1D, e.g. 
temporal convolution 

layer_conv_2d_transpose() 
Transposed 2D (deconvolution) 

layer_conv_2d() 2D, e.g. spatial 
convolution over images 

layer_conv_3d_transpose() 
Transposed 3D (deconvolution) 
layer_conv_3d() 3D, e.g. spatial 
convolution over volumes 

layer_conv_lstm_2d() 
Convolutional LSTM 

layer_separable_conv_2d() 
Depthwise separable 2D 

layer_upsampling_1d() 
layer_upsampling_2d() 
layer_upsampling_3d() 
Upsampling layer 

layer_zero_padding_1d() 
layer_zero_padding_2d() 
layer_zero_padding_3d()  
Zero-padding layer 

layer_cropping_1d() 
layer_cropping_2d() 
layer_cropping_3d() 
Cropping layer

layer_max_pooling_1d() 
layer_max_pooling_2d() 
layer_max_pooling_3d()  
Maximum pooling for 1D to 3D 

layer_average_pooling_1d() 
layer_average_pooling_2d() 
layer_average_pooling_3d() 
Average pooling for 1D to 3D 

layer_global_max_pooling_1d() 
layer_global_max_pooling_2d()  
layer_global_max_pooling_3d() 
Global maximum pooling 

layer_global_average_pooling_1d()  
layer_global_average_pooling_2d()  
layer_global_average_pooling_3d() 
Global average pooling

Preprocessing
SEQUENCE PREPROCESSING

pad_sequences() 
Pads each sequence to the same length (length of 
the longest sequence) 

skipgrams() 
Generates skipgram word pairs 

make_sampling_table() 
Generates word rank-based probabilistic sampling 
table 

TEXT PREPROCESSING

text_tokenizer() Text tokenization utility 

fit_text_tokenizer() Update tokenizer internal 
vocabulary 

save_text_tokenizer(); load_text_tokenizer() 
Save a text tokenizer to an external file 

texts_to_sequences(); 
texts_to_sequences_generator() 
Transforms each text in texts to sequence of integers 

texts_to_matrix(); sequences_to_matrix() 
Convert a list of sequences into a matrix 

text_one_hot() One-hot encode text to word indices 

text_hashing_trick() 
Converts a text to a sequence of indexes in a fixed-
size hashing space 

text_to_word_sequence()  
Convert text to a sequence of words (or tokens)

IMAGE PREPROCESSING

image_load() Loads an image into PIL format. 

flow_images_from_data() 
flow_images_from_directory()  
Generates batches of augmented/normalized data 
from images and labels, or a directory 

image_data_generator() Generate minibatches of 
image data with real-time data augmentation. 

fit_image_data_generator() Fit image data 
generator internal statistics to some sample data 

generator_next() Retrieve the next item 

image_to_array(); image_array_resize() 
image_array_save() 3D array representation

ACTIVATION LAYERS

layer_activation(object, activation) 
Apply an activation function to an output 

layer_activation_leaky_relu()  
Leaky version of a rectified linear unit 

layer_activation_parametric_relu() 
Parametric rectified linear unit 

layer_activation_thresholded_relu() 
Thresholded rectified linear unit 

layer_activation_elu() 
Exponential linear unit 

α

DROPOUT LAYERS

layer_dropout() 
Applies dropout to the input 

layer_spatial_dropout_1d() 
layer_spatial_dropout_2d() 
layer_spatial_dropout_3d() 
Spatial 1D to 3D version of dropout 

LOCALLY CONNECTED LAYERS

layer_locally_connected_1d() 
layer_locally_connected_2d() 
Similar to convolution, but weights are not 
shared, i.e. different filters for each patch

RECURRENT LAYERS

layer_simple_rnn() 
Fully-connected RNN where the output 
is to be fed back to input 

layer_gru() 
Gated recurrent unit - Cho et al 

layer_cudnn_gru() 
Fast GRU implementation backed 
by CuDNN 

layer_lstm() 
Long-Short Term Memory unit - 
Hochreiter 1997 

layer_cudnn_lstm() 
Fast LSTM implementation backed 
by CuDNN 

application_xception() 
xception_preprocess_input() 
Xception v1 model 

application_inception_v3() 
inception_v3_preprocess_input() 
Inception v3 model, with weights pre-trained 
on ImageNet 

application_inception_resnet_v2() 
inception_resnet_v2_preprocess_input() 
Inception-ResNet v2 model, with weights 
trained on ImageNet 

application_vgg16(); application_vgg19()  
VGG16 and VGG19 models 

application_resnet50() ResNet50 model 

application_mobilenet() 
mobilenet_preprocess_input() 
mobilenet_decode_predictions() 
mobilenet_load_model_hdf5() 
MobileNet model architecture 

ImageNet is a large database of images with 
labels, extensively used for deep learning 

imagenet_preprocess_input() 
imagenet_decode_predictions() 
Preprocesses a tensor encoding a batch of 
images for ImageNet, and decodes predictions

Keras applications are deep learning models 
that are made available alongside pre-trained 
weights. These models can be used for 
prediction, feature extraction, and fine-tuning.

A callback is a set of functions to be applied at 
given stages of the training procedure. You can 
use callbacks to get a view on internal states 
and statistics of the model during training. 

callback_early_stopping() Stop training when 
a monitored quantity has stopped improving 
callback_learning_rate_scheduler() Learning 
rate scheduler 
callback_tensorboard() TensorBoard basic 
visualizations 

Pre-trained models

Callbacks

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at keras.rstudio.com  •  keras 2.1.2  •  Updated: 2017-12
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fd
YARN

Mesos
or 

fd

fd

fd

fd

fd
• spark.yarn.am.cores 
• spark.yarn.am.memory 512m 
• spark.network.timeout 120s 
• spark.executor.memory 1g 
• spark.executor.cores  1

library(sparklyr); library(dplyr); library(ggplot2); 
library(tidyr);  
set.seed(100) 

spark_install("2.0.1") 

sc <- spark_connect(master = "local") 

import_iris <- copy_to(sc, iris, "spark_iris",  
   overwrite = TRUE)  

partition_iris <- sdf_partition( 
   import_iris,training=0.5, testing=0.5) 
   
sdf_register(partition_iris, 
c("spark_iris_training","spark_iris_test")) 

tidy_iris <- tbl(sc,"spark_iris_training") %>% 
  select(Species, Petal_Length, Petal_Width)  

model_iris <- tidy_iris %>% 
  ml_decision_tree(response="Species",  
  features=c("Petal_Length","Petal_Width")) 

test_iris <- tbl(sc,"spark_iris_test")  

pred_iris <- sdf_predict( 
  model_iris,  test_iris) %>%  
  collect 

pred_iris %>% 
  inner_join(data.frame(prediction=0:2, 
  lab=model_iris$model.parameters$labels)) %>% 
  ggplot(aes(Petal_Length, Petal_Width, col=lab)) + 
  geom_point() 

spark_disconnect(sc)

Partition 
data

Install Spark locally

Connect to  local version

Copy data to Spark memory

Create a hive metadata for each partition

Bring data back 
into R memory 

for plotting

A brief example of a data analysis using 
Apache Spark, R and sparklyr in local mode

Spark ML 
Decision Tree 

Model

Create 
reference to 
Spark table

Disconnect

• Collect data 
into R 

• Share plots, 
documents, 
and apps• Spark MLlib 

• H2O Extension

Collect data into 
R for plotting

Transformer 
function

• dplyr verb 
• Direct Spark 

SQL (DBI) 
• SDF function 

(Scala API)

• Export an R 
DataFrame 

• Read a file 
• Read existing 

Hive table

Data Science in Spark with Sparklyr : : CHEAT SHEET 
Intro Using  

sparklyr

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at spark.rstudio.com  •  sparklyr  0.5  •  Updated: 2016-12

sparklyr is an R interface for Apache Spark™, 
it provides a complete dplyr backend and the 
option to query directly using Spark SQL 
statement. With sparklyr, you can orchestrate 
distributed machine learning using either 
Spark’s MLlib or H2O Sparkling Water.

Import Tidy Transform

Model

Visualize Communicate

R for Data Science, Grolemund & Wickham

Disconnect

Open the 
Spark UI

Spark & Hive Tables

Open connection log

Preview 
1K rows

RStudio Integrates with sparklyr

Starting with version 1.044, RStudio Desktop, 
Server and Pro include integrated support for 
the sparklyr package.  You can create and 
manage connections to Spark clusters and local 
Spark instances from inside the IDE.  

config <- spark_config() 
config$spark.executor.cores <- 2 
config$spark.executor.memory <- "4G" 
sc <- spark_connect (master="yarn-client",  
config = config, version = "2.0.1")

Understand

Wrangle

Cluster Deployment
MANAGED CLUSTER

Driver Node

Worker Nodes
Cluster Manager

STAND ALONE CLUSTER

Driver Node

Worker Nodes Tuning Spark
EXAMPLE CONFIGURATION IMPORTANT TUNING PARAMETERS with defaults

• spark.executor.instances 
• spark.executor.extraJavaOptions 
• spark.executor.heartbeatInterval 10s 
• sparklyr.shell.executor-memory  
• sparklyr.shell.driver-memory

Getting Started

Data Science Toolchain with Spark + sparklyr

1. Install a local version of Spark: 
spark_install ("2.0.1") 

2. Open a connection 
sc <- spark_connect (master = "local") 

LOCAL MODE (No cluster required)

1. Install RStudio Server or Pro on one  of the 
existing nodes 

2. Locate path to the cluster’s Spark directory 
3. Open a connection 

spark_connect(master=“[mesos URL]”,     
version = “1.6.2”,  spark_home = 
[Cluster’s Spark path])

ON A MESOS MANAGED CLUSTER

1. The Livy REST application should be 
running on the cluster 

2. Connect to the cluster 
sc <- spark_connect(method = "livy", 
master = "http://host:port")

USING LIVY (Experimental)

1. Install RStudio Server or RStudio Pro on 
one of the existing nodes, preferably an 
edge node 

2. Locate path to the cluster’s Spark Home 
Directory, it normally is “/usr/lib/spark” 

3. Open a connection 
spark_connect(master=“yarn-client”, 
version = “1.6.2”,  spark_home = 
[Cluster’s Spark path])

ON A YARN MANAGED CLUSTER

1. Install RStudio Server or RStudio Pro on 
one of the existing nodes or a server in  the 
same LAN 

2. Install a local version of Spark:         
spark_install (version = “2.0.1") 

3. Open a connection 
spark_connect(master=“spark://
host:port“,  version = "2.0.1",  
spark_home = spark_home_dir())

ON A SPARK STANDALONE CLUSTER



ft_binarizer(my_table,input.col=“Petal_Le
ngth”,  output.col="petal_large", 
threshold=1.2) 

Arguments that apply to all functions:  
x, input.col = NULL, output.col =  NULL 

ft_binarizer(threshold = 0.5) 
Assigned values based on threshold 

ft_bucketizer(splits) 
Numeric column to discretized column 

ft_discrete_cosine_transform(inverse 
= FALSE) 

Time domain to frequency domain 

ft_elementwise_product(scaling.col) 
Element-wise product between 2 cols 

ft_index_to_string() 
Index labels back to label as strings 

ft_one_hot_encoder() 
Continuous to binary  vectors 

ft_quantile_discretizer(n.buckets=5L) 
Continuous to binned categorical 
values 

ft_sql_transformer(sql) 
ft_string_indexer( params = NULL) 

Column of labels into a column of label 
indices.  

ft_vector_assembler() 
Combine vectors into single row-vector

invoke()                  Call a method on a Java object
invoke_new()                                Create a new object by invoking a 

constructor

COPY A DATA FRAME INTO SPARK
Reactivity Visualize & Communicate Model (MLlib)

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at spark.rstudio.com  •  sparklyr  0.5  •  Updated: 2016-12

dplyr::collect(x)

r_table <- collect(my_table) 
plot(Petal_Width~Petal_Length, data=r_table)

sdf_read_column(x, column)
Returns contents of a single column to R

my_var <- tbl_cache(sc, name= 
"hive_iris")

tbl_cache(sc, name, force = TRUE)
Loads the table into memory

my_var <- dplyr::tbl(sc, 
name= "hive_iris")

dplyr::tbl(scr, …)
Creates a reference to the table 
without loading it into memory

sdf_copy_to(sc, x, name, memory, repartition, 
overwrite)

sdf_copy_to(sc, iris, "spark_iris") DBI::dbWriteTable(sc, "spark_iris", iris)

DBI::dbWriteTable(conn, name, 
value)

Translates into Spark SQL statements

my_table <- my_var %>% 
      filter(Species=="setosa") %>% 
      sample_n(10)

my_table <- DBI::dbGetQuery( sc , ”SELECT * 
FROM iris LIMIT 10")

DBI::dbGetQuery(conn, statement)

spark_read_<fmt>

sdf_copy_to

DBI::dbWriteTable

dplyr::collect
sdf_read_column

spark_write_<fmt>

tbl_cache
dplyr::tbl

File 
System 

Download a Spark DataFrame to an R DataFrame

Create an R package that calls the full Spark API & 
provide interfaces to Spark packages.

spark_connection()                                            Connection between R and the 
Spark shell process
                           Instance of a remote Spark object
                                           Instance of a remote Spark 
DataFrame object

invoke_static()                                 Call a static method on an object

spark_jobj()

spark_read_csv( header = TRUE, 
delimiter = ",", quote = "\"", escape = "\\", 
charset = "UTF-8", null_value = NULL)
spark_read_json(mode = NULL)

spark_read_parquet(mode = NULL)

Arguments that apply to all  functions: x, path

CSV

JSON
PARQUET

spark_read_csv( header = TRUE, 
columns = NULL, infer_schema = TRUE, 
delimiter = ",", quote = "\"", escape = "\\", 
charset = "UTF-8", null_value = NULL)
spark_read_json()
spark_read_parquet()

Arguments that apply to all  functions:  
sc, name, path, options = list(),  repartition =  0,  

memory = TRUE, overwrite = TRUE

CSV

JSON
PARQUET

sdf_collect

dplyr::copy_to

spark_dataframe()

sparklyr 

is an R 
interface 

for 
ml_create_dummy_variables()

ml_model()ml_prepare_dataframe()
ml_prepare_response_features_intercept()

ml_options()

ml_decision_tree(my_table,  
response = “Species",  features =  
c(“Petal_Length" , "Petal_Width")) 

ml_als_factorization(x, user.column = "user", 
rating.column = "rating",  item.column = "item", 
rank = 10L, regularization.parameter = 0.1,  iter.max = 10L, 
ml.options = ml_options()) 

ml_decision_tree(x, response, features, max.bins = 32L, max.depth 
= 5L,  type = c("auto", "regression", "classification"),  ml.options = 
ml_options()) Same options for: ml_gradient_boosted_trees 

ml_generalized_linear_regression(x, response, features, 
intercept = TRUE,  family = gaussian(link = "identity"), iter.max = 
100L,  ml.options = ml_options()) 

ml_kmeans(x, centers, iter.max = 100, features = dplyr::tbl_vars(x), 
compute.cost = TRUE, tolerance = 1e-04, ml.options = ml_options()) 

ml_lda(x, features = dplyr::tbl_vars(x), k = length(features),  alpha = 
(50/k) + 1, beta = 0.1 + 1, ml.options = ml_options()) 

ml_linear_regression(x, response, features, intercept = TRUE, 
alpha = 0, lambda = 0, iter.max = 100L, ml.options = ml_options()) 
Same options for: ml_logistic_regression 

ml_multilayer_perceptron(x, response, features, layers, iter.max = 
100, seed = sample(.Machine$integer.max, 1), ml.options = 
ml_options()) 

ml_naive_bayes(x, response, features, lambda = 0, ml.options = 
ml_options()) 

ml_one_vs_rest(x, classifier, response, features, ml.options = 
ml_options()) 

ml_pca(x, features = dplyr::tbl_vars(x), ml.options = ml_options()) 
ml_random_forest(x, response, features, max.bins = 32L, 

max.depth = 5L,  num.trees = 20L, type = c("auto", "regression", 
"classification"),  ml.options = ml_options()) 

ml_survival_regression(x, response, features, intercept = 
TRUE,censor = "censor", iter.max = 100L, ml.options =  ml_options()) 

ml_binary_classification_eval(predicted_tbl_spark, label, score,  
metric = "areaUnderROC") 

ml_classification_eval(predicted_tbl_spark, label, predicted_lbl, 
metric = "f1") 

ml_tree_feature_importance(sc, model)

IMPORT INTO SPARK FROM A FILE

SPARK SQL COMMANDS

FROM A TABLE IN HIVE

Wrangle
SPARK SQL VIA DPLYR VERBS

DIRECT SPARK SQL COMMANDS

SCALA API VIA SDF FUNCTIONS

ML TRANSFORMERS

DOWNLOAD DATA TO R MEMORY

SAVE FROM SPARK TO FILE SYSTEM

Reading & Writing from Apache Spark

Extensions

CORE TYPES

CALL SPARK FROM R

MACHINE LEARNING EXTENSIONS

sdf_mutate(.data) 
Works like dplyr mutate function 

sdf_partition(x, ..., weights = NULL, seed = 
sample (.Machine$integer.max,  1)) 

sdf_partition(x, training = 0.5, test = 0.5) 

sdf_register(x, name = NULL) 
Gives a Spark DataFrame a table name  

sdf_sample(x, fraction = 1, replacement = 
TRUE, seed = NULL) 
sdf_sort(x, columns) 

Sorts by >=1 columns in ascending order 

sdf_with_unique_id(x, id = "id") 
sdf_predict(object, newdata) 

Spark DataFrame with predicted values



Symbol - a name that represents a value  
or object stored in R. is_symbol(expr(pi)) 

Environment - a list-like object that binds 
symbols (names) to objects stored in memory.  
Each env contains a link to a second, parent  
env, which creates a chain, or search path, of 
environments. is_environment(current_env()) 

Constant - a bare value (i.e. an atomic  
vector of length 1). is_bare_atomic(1) 

Call object - a vector of symbols/constants/calls  
that begins with a function name, possibly 
followed by arguments. is_call(expr(abs(1))) 

Code - a sequence of symbols/constants/calls 
that will return a result if evaluated. Code can be: 

1. Evaluated immediately     (Standard Eval) 
2. Quoted to use later   (Non-Standard Eval) 
is_expression(expr(pi)) 

Expression - an object that stores quoted code 
without evaluating it. is_expression(expr(a + b)) 

Quosure- an object that stores both quoted  
code (without evaluating it) and the code's 
environment. is_quosure(quo(a + b)) 

Expression Vector - a list of pieces of quoted 
code created by base R's expression and parse 
functions. Not to be confused with expression.

rlang::quo_get_env(quo) Return  
the environment of a quosure. 

rlang::quo_set_env(quo, expr) 
Set  the environment of a quosure. 

rlang::quo_get_expr(quo) Return 
the expression of a quosure.
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Tidy evaluation with rlang : : CHEAT SHEET 

3.14
pi code

result

1

abs ( )1

a + b

ba

Quoting Code                       

Parsing and Deparsing

QUOSURES EXPRESSION
Quosure- An expression that has 
been saved with an environment 
(aka a closure).  
A quosure can be evaluated later  
in the stored environment to  
return a predictable result.

a + b,
q

a
b

when  
evaluated

a + b
3

b
a

Quoted Expression - An expression 
that has been saved by itself.  
A quoted expression can be  evaluated 
later to return a result that will depend 
on the environment it is evaluated ina + b

e when  
evaluated

a + b
?

?

rlang::quo(expr) Quote contents as a quosure. Also quos to quote 
multiple expressions. a <- 1; b <- 2; q <- quo(a + b); qs <- quos(a, b) 

rlang::enquo(arg) Call from within a function to quote what the user 
passed to an argument as a quosure. Also enquos for multiple args. 
quote_this < - function(x) enquo(x) 
quote_these < - function(…) enquos(…) 

rlang::new_quosure(expr, env = caller_env()) Build a  
quosure from a quoted expression and an environment. 
new_quosure(expr(a + b), current_env())

rlang::expr(expr) Quote contents. Also exprs to quote multiple 
expressions. a <- 1; b <- 2; e <- expr(a + b); es <- exprs(a, b, a + b) 

rlang::enexpr(arg) Call from within a function to quote what the user 
passed to an argument. Also enexprs to quote multiple arguments.  
quote_that < - function(x) enexpr(x) 
quote_those < - function(…) enexprs(…) 

rlang::ensym(x) Call from within a function to quote what the user 
passed to an argument as a symbol, accepts strings. Also ensyms.  
quote_name < - function(name) ensym(name) 
quote_names < - function(…) ensyms(…)

a + b,
q

a b

a + b
e

Tidy Evaluation (Tidy Eval) is not a package, but a framework 
for doing non-standard evaluation (i.e. delayed evaluation) that 
makes it easier to program with tidyverse functions.

To evaluate an expression, R : 
1.Looks up the symbols in the expression in 

the active environment (or a supplied one), 
followed by the environment's parents 

2.Executes the calls in the expression 

The result of an expression depends on  
which environment it is evaluated in.

ba

rlang::parse_expr(x) Convert  
a string  to an expression. Also 
parse_exprs, sym, parse_quo, 
parse_quos. e<-parse_expr("a+b")

a + b
e"a + b" "a + b"

Parse - Convert a string 
to a saved expression. 

Deparse - Convert a saved 
expression to a string. 

rlang::expr_text(expr, width = 
60L, nlines = Inf) Convert expr 
to a string. Also quo_name. 
expr_text(e) 

b
a 1

2

a 1

b
+ fun

2

a + b
3

fun(1, 2)

Evaluation

rlang::eval_tidy(expr, data = NULL, 
env = caller_env()) Evaluate expr in 
env, using data as a data mask. 
Will evaluate quosures in their 
stored environment. eval_tidy(q) 

Data Mask - If data is non-NULL, 
eval_tidy inserts data into the 
search path before env, matching 
symbols to names in data. 

Use the pronoun .data$ to force a 
symbol to be matched in data, and  
!! (see back) to force a symbol to 
be matched in the environments.

a + b

b+

a

a <- 1; b <- 2 
p <- quo(.data$a + !!b) 
mask <- tibble(a = 5, b = 6)  
eval_tidy(p, data = mask)

QUOTED EXPRESSION QUOSURES (and quoted exprs)

rlang::caller_env(n = 1) Returns 
calling env of the function it is in.   

rlang::child_env(.parent, ...) Creates 
new env as child of .parent. Also env. 

rlang::current_env() Returns 
execution env of the function it is in.

pi

a + b
e

3
a + b

Quote code in one of two ways (if in doubt use a quosure): 

parse deparse

rlang::eval_bare(expr, env = 
parent.frame()) Evaluate expr in 
env. eval_bare(e, env =.GlobalEnv)

Building Calls
rlang::call2(.fn, ..., .ns = NULL) Create a call from a function and a list 
of args. Use exec to create and then evaluate the call. (See back page 
for !!!) args <- list(x = 4, base = 2)

call2("log", x = 4, base = 2) 
call2("log", !!!args) 

exec("log", x = 4, base = 2) 
exec("log", !!!args)

, base =4log (x = )2

2

Vocabulary



PASS CRAN CHECK

Quoted arguments in tidyverse functions 
can trigger an R CMD check NOTE about 
undefined global variables. To avoid this: 

1. Import rlang::.data to your package,  
perhaps with the roxygen2 tag 
@importFrom rlang .data 

2. Use the .data$ pronoun in front of 
variable names in tidyverse functions

APPLY AN ARGUMENT TO A DATA FRAME

subset2 <- function(df, rows) { 
    rows <- rlang::enquo(rows) 
    vals <- rlang::eval_tidy(rows, data = df) 
    df[vals, , drop = FALSE] 
}

1

2

1. Capture user argument  
with rlang::enquo. 

2. Evaluate the argument with 
rlang::eval_tidy. Pass the data 
frame to data to use as a data mask. 

3. Suggest in your documentation 
that your users use the .data 
and .env pronouns.
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Quasiquotation (!!, !!!, :=)

Quoting some parts of an 
expression while evaluating 
and then inserting the results 
of others (unquoting others). 
e <- expr(a + b)

rlang provides !!, !!!, and := for doing quasiquotation. 

!!, !!!, and := are not functions but syntax (symbols recognized 
by the functions they are passed to). Compare this to how  

. is used by magrittr::%>%() 

. is used by stats::lm() 

.x is used by purrr::map(), and so on. 

!!, !!!, and := are only recognized by some rlang functions and 
functions that use those functions (such as tidyverse functions).

QUOTATION QUASIQUOTATION

( ) log(a + b)
fun
log a + b

e
( ) log(e)

fun
log

a + b
e

Storing an expression 
without evaluating it. 
e <- expr(a + b)

!!   Unquotes the 
symbol or call that 
follows. Pronounced 
"unquote" or "bang-
bang." a <- 1; b <- 2 
expr(log(!!a + b)) 

Combine !! with ()  
to unquote a longer 
expression.  
a <- 1; b <- 2 
expr(log(!!(a + b))) 

!!!   Unquotes a vector 
or list and splices the 
results as arguments 
into the surrounding 
call. Pronounced 
"unquote splice" or 
"bang-bang-bang." 
x <- list(8, b = 2)  
expr(log(!!!x)) 

:=   Replaces an = to 
allow unquoting within 
the name that appears 
on the left hand side of 
the =. Use with !! 
n <- expr(uno) 
tibble::tibble(!!n := 1)

expr(log(!!a + b))

1
a

fun
+

2
b( )

fun
log log(1 + b)

!!

expr(log(!!(a + b)))

3
a + b

( )
fun
log log(3)

!!

expr(log(!!!x))

8, b = 2
x

( )
fun
log log(8, b=2)

!!!

tibble::tibble(!!n := 1)

uno
n

1
1 uno = 1:=

!!

Programming Recipes

PROGRAM WITH A QUOTING FUNCTION

WRITE A 
FUNCTION  
THAT RECOGNIZES  
QUASIQUOTATION 
(!!,!!!,:=)

Quoting function- A function that quotes any of  its arguments internally  for delayed evaluation 
in a chosen environment. You must take special steps to program safely with a quoting function.

PASS MULTIPLE ARGUMENTS  
TO A QUOTING FUNCTION

PASS TO ARGUMENT NAMES  
OF A QUOTING FUNCTION

MODIFY USER ARGUMENTS 

Many tidyverse functions are quoting 
functions: e.g. filter, select, mutate, 
summarise, etc.

How to spot a quoting function?  
A function quotes an argument if the 
argument returns an error when run 
on its own.

  speed dist
1    25   85

dplyr::filter(cars, speed = = 25)

Error!
speed == 25

my_do <- function(f, v, df) { 
    f <- rlang::enquo(f) 
    v <- rlang::enquo(v) 
    todo <- rlang::quo((!!f)(!!v)) 
    rlang::eval_tidy(todo, df) 
}

1

2
3

1. Capture user arguments  
with rlang::enquo. 

2. Unquote user arguments into a 
new expression or quosure to use 

3. Evaluate the new expression/
quosure instead of the original 
argument

data_mean <- function(data, var) { 
    require(dplyr) 
    var <- rlang::enquo(var) 
    data %>% 
        summarise(mean = mean(!!var)) 
}

1

2

1. Capture user argument that will 
be quoted with rlang::enquo. 

2. Unquote the user argument into 
the quoting function with !!.

group_mean <- function(data, var, …) { 
    require(dplyr) 
    var <- rlang::enquo(var) 
    group_vars <- rlang::enquos(…) 
    data %>% 
         group_by(!!!group_vars) %>% 
        summarise(mean = mean(!!var)) 
}

1

2

1. Capture user arguments that will 
be quoted with rlang::enquos. 

2. Unquote splice the user arguments 
into the quoting function with !!!.

named_mean <- function(data, var) { 
    require(dplyr) 
    var <- rlang::ensym(var) 
   data %>% 
       summarise(!!name := mean(!!var)) 
}

1

2

1. Capture user argument that will 
be quoted with rlang::ensym. 

2. Unquote the name into the 
quoting function with !! and :=.

expr(log(e)) expr(log(!!e))

add1 <- function(x) { 
    q <- rlang::enquo(x) 
    rlang::eval_tidy(q) + 1 
}

1
2

1. Capture the  
quasiquotation-aware  
argument with rlang::enquo. 

2. Evaluate the arg with rlang::eval_tidy.

#' @importFrom rlang .data 
mutate_y <- function(df) { 
   dplyr::mutate(df, y = .data$a +1) 
}

1

2
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train(y ~ x1 + x2, data = dat, ...)
train(x = predictor_df, y = outcome_vector, ...)
train(recipe_object, data = dat, ...)

Possible syntaxes for specifying the variables in the model:

• rfe, sbf, gafs, and safs only have the x/y interface. 

• The train formula method will always create dummy 
variables. 

• The x/y interface to train will not create dummy variables 
(but the underlying model function might).

Remember to:

• Have column names in your data. 

• Use factors for a classification outcome (not 0/1 or integers). 

• Have valid R names for class levels (not “0"/"1") 

• Set the random number seed prior to calling train repeatedly 
to get the same resamples across calls. 

• Use the train option na.action = na.pass if you will 
being imputing missing data. Also, use this option when 
predicting new data containing missing values. 

To pass options to the underlying model function, you can pass 
them to train via the ellipses:

train(y ~ ., data = dat, method = "rf", 
      # options to `randomForest`:
      importance = TRUE)

Specifying the Model

Parallel Processing
The foreach package is used to run models in parallel. The 
train code does not change but a “do” package must be called 
first.

# on MacOS or Linux
library(doMC)
registerDoMC(cores=4)

train(, preProc = c("method1", "method2"), ...)

Transformations, filters, and other operations can be applied to 
the predictors with the preProc option.

• "center", "scale", and "range" to normalize predictors.
• "BoxCox", "YeoJohnson", or "expoTrans" to transform 

predictors. 

• "knnImpute", "bagImpute", or "medianImpute" to 
impute. 

• "corr", "nzv", "zv", and "conditionalX" to filter. 

• "pca", "ica", or "spatialSign" to transform groups.

Preprocessing

Adding Options
Many train options can be specified using the trainControl 
function:

train(y ~ ., data = dat, method = "cubist", 
      trControl = trainControl(<options>))

# on Windows
library(doParallel)
cl <- makeCluster(2)
registerDoParallel(cl)

The function parallel::detectCores can help too.

Methods include:

train determines the order of operations; the order that the 
methods are declared does not matter.  

The recipes package has a more extensive list of preprocessing 
operations.

Resampling Options
trainControl is used to choose a resampling method:

trainControl(method = <method>, <options>)

Methods and options are:
• "cv" for K-fold cross-validation (number sets the # folds). 

• "repeatedcv" for repeated cross-validation (repeats for # 
repeats). 

• "boot" for bootstrap  (number sets the iterations). 

• "LGOCV" for leave-group-out (number and p are options). 

• "LOO" for leave-one-out cross-validation. 

• "oob" for out-of-bag resampling (only for some models). 

• "timeslice" for time-series data (options are 
initialWindow, horizon, fixedWindow, and skip).

To choose how to summarize a model, the  trainControl 
function is used again. 

Performance Metrics

trainControl(summaryFunction = <R function>, 
             classProbs = <logical>)
Custom R functions can be used but caret includes several: 
defaultSummary (for accuracy, RMSE, etc), twoClassSummary 
(for ROC curves), and prSummary (for information retrieval). For 
the last two functions, the option classProbs must be set to 
TRUE.

Grid Search
To let train determine the values of the tuning parameter(s), the 
tuneLength option controls how many values per tuning 
parameter to evaluate.  

Alternatively, specific values of the tuning parameters can be 
declared using the tuneGrid argument:

grid <- expand.grid(alpha = c(0.1, 0.5, 0.9), 
                    lambda = c(0.001, 0.01))

train(x = x, y = y, method = "glmnet",
      preProc = c("center", "scale"),
      tuneGrid = grid)

Random Search

For tuning, train can also generate random tuning parameter 
combinations over a wide range. tuneLength  controls the total 
number of combinations to evaluate. To use random search:

trainControl(search = "random")

Subsampling
With a large class imbalance, train can subsample the data to 
balance the classes them prior to model fitting. 

trainControl(sampling = "down")

Other values are "up", "smote", or "rose". The latter two may 
require additional package installs.  



Notes:
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